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Section I - Getting started
• Introduction
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Introduction

About Enterprise Edge Voice Messaging
Enterprise Edge Voice Messaging works with your Enterprise Edge telephon
system and Enterprise Edge Voice Applications Manager, the Administration
software, to give you easy access to administering Enterprise Edge.

For more information on installing and using Enterprise Edge Voice Applicatio
Manager see Appendix B: Enterprise Edge Configuration Tips on page 145.

Enterprise Edge Voice Messaging is available in two different packages: basic
optional.

Basic Enterprise Edge Voice Messaging
The following is a brief description of the basic Enterprise Edge Integrated Solu
software.

Voice Messaging
Accurately records callers’ messages and stores them in a mailbox for easy 
retrieval. Each Enterprise Edge telephone in your system can have its own ma
and personal greeting.

Automated Attendant
Answers your business calls promptly, 24 hours a day, with a Company Gree
A voice prompt offers callers a menu of options to direct their call by selecting
digit on the dialpad.

Custom Call Routing (CCR)
Enhances the Automated Attendant menu with a customized CCR Home Me
offer callers a wider range of call routing options and access to sub-menus as
as information messages. CCR allows you to determine the menu options an
record the voice prompts that guide callers along call paths.

1
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Enterprise Edge Integrated Solution optional software
Enterprise Edge Integrated Solution optional software includes all the feature
Enterprise Edge Voice Messaging and the following components that enhance
office communications.

Enterprise Edge Message Networking
Enterprise Edge Message Networking links Enterprise Edge Voice Messagin
other voice mail systems at different locations. Message Networking allows th
exchange of Voice Messages between users at different sites connected on a
network via Transmission Control Protocol/Internet Protocol (TCP/IP).

Audio Messaging Interchange Specification (AMIS) Networking and Digital Networking

Includes General Networking parameters, Audio Messaging Interchange 
Specification (AMIS)-specific parameters and AMIS Site Administration. Refe
the Enterprise Edge 2.0 Voice Messaging AMIS Set Up and Operation Guide for 
information about AMIS Networking. For information about digital networking
refer to the Enterprise Edge 2.0 Message Networking Set Up and Operation G.

Enterprise Edge Unified Messaging
Enterprise Edge Unified Messaging consists of three features:

• Enterprise Edge Unified Messaging

• Enterprise Edge Personal Mailbox Manager

• Enterprise Edge Operator Manager

Enterprise Edge Unified Messaging

Enterprise Edge Unified Messaging lets you create and receive Enterprise Ed
Voice Messaging messages on your personal computer (PC).

Enterprise Edge Personal Mailbox Manager

Enterprise Edge Personal Mailbox Manager lets you administer from a PC al
mailbox features and functions that are available through ƒ·°⁄. 
Enterprise Edge Personal Mailbox Manager gives you the ability to:

• Initialize your personal mailbox

• Record your primary, personal and alternate greetings

• Select your primary, personal and alternate greetings

• Change your spoken name that appears in the Company Directory

• Change your Target Attendant

• Set up and maintain Off-premise Message Notification

• Set up and maintain Outbound Transfer
Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide P0911620 Issue 02
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Enterprise Edge Personal Mailbox Manager also gives the System Administr
access to Information Mailboxes, the System Administrator Mailbox, the Busin
Open status tab and the record Company Greetings tab.

Enterprise Edge Operator Manager

Enterprise Edge Operator Manager lets the System Administrator administer 
a PC the Enterprise Edge Voice Messaging features and functions that are ava
through ƒ·°¤. Enterprise Edge Operator Manager gives you the
ability to:

• Change the Operator password

• Change the Business Status to open or closed

• Enable and disable the system attendant (Operator)

• Change the extension of the system attendant (Operator)

• Enable and disable the Enterprise Edge Voice Messaging Call Answer fea
(Automated Attendant and call answering)

Enterprise Edge Call Center
The Enterprise Edge Call Center system handles incoming calls as efficiently
economically as possible. Incoming calls are distributed to available agents o
Enterprise Edge Call Center greetings in your call center. To ensure that eac
is handled successfully, the Enterprise Edge Call Center system answers, pla
greetings and routes each incoming call to the first available agent in the orde
the call’s arrival.

Enterprise Edge Call Center is an Enterprise Edge Voice Messaging system o
that is enabled with a Security Keycode.
P0911620 Issue 02 Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide
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How this guide is organized
This guide leads a System Administrator through setting up the Enterprise Ed
Voice Messaging system and serves as an ongoing reference aid. The instru
in this guide are presented in easy-to-follow steps that cover all aspects of se
up and administering your Enterprise Edge Voice Messaging system.

This section tells you what to expect as you read the guide, and how informat
presented.

The Appendices at the back of this guide include detailed information on topi
relevant to setting up and operating the Enterprise Edge Voice Messaging sy

Symbols and conventions
The following conventions and symbols are used to describe the words that a
on the telephone display and dialpad.

What appears on the display
The telephone displays in this guide use the Enterprise Edge Voice Messagin
default settings and sample names.

 For example:

This display shows an example of the Enterprise Edge Voice Messaging exte
number.

Prerequisites
Before you set up Enterprise Edge Voice Messaging, ensure you are familiar
how Enterprise Edge Voice Applications Manager works.

Convention/Symbol Example Purpose

Display font, mixed case Pswd: Display prompts. Used on one- and two-
line display telephones. You must perform
an action in response to the prompt.

Display font, word in capital 
letters and underlined

 MBOX Display button option. Appears on two-line 
display telephones only. Press the button 
directly below the option on the display to 
proceed.

Dialpad buttons £ Represents the buttons you press on the 
dialpad to select a particular option.

Set 2100
                                OK
Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide P0911620 Issue 02
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The Enterprise Edge Voice Messaging document set

Document Audience Description

Enterprise Edge 2.0 Voice Messaging 
Quick Reference Guide

All users Describes how to use the most 
common Enterprise Edge Voice 
Messaging commands and 
features.

Enterprise Edge 2.0 Voice Messaging 
Reference Guide

All users A more detailed, procedural 
description of the Enterprise 
Edge Voice Messaging 
commands and features 
available to end users.

Enterprise Edge 2.0 Voice Messaging Set 
Up and Operation Guide

System 
Administrator

Instructions for setting up, 
programming, and operating the 
Enterprise Edge Voice 
Messaging system.

Enterprise Edge 2.0 Voice Messaging 
Programming Record

System 
Administrator

Planning sheets to support the 
Enterprise Edge Voice 
Messaging System 
Administrator programming 
tasks.

Enterprise Edge 2.0 Voice Messaging 
AMIS Set Up and Operation Guide

System 
Administrator

Instructions for setting up and 
programming the optional 
AMIS software.

Enterprise Edge 2.0 Voice Messaging 
AMIS User Guide

All users Information about programming 
and using the optional AMIS 
software.

Enterprise Edge 2.0 Voice Messaging FAX 
Set Up and Operation Guide

System 
Administrator

Instructions for setting up and 
programming the optional FAX 
software.

Enterprise Edge 2.0 Voice Messaging FAX 
User Guide

All users Information about programming 
and using the optional FAX 
software.
P0911620 Issue 02 Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide
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Section II - Preparing Enterprise Edge
Voice Messaging for use

• Using Enterprise Edge Voice Applications Manager
• Setting up Enterprise Edge Voice Messaging
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Using Enterprise Edge Voice Applications 
Manager

Overview
Enterprise Edge Voice Applications Manager is a Windows® based application that
lets the System Administrator set up and administer Enterprise Edge Voice 
Messaging features.

Enterprise Edge Voice Applications Manager can be accessed by clicking the
Enterprise Edge Voice Messaging icon on the Enterprise Edge Voice Applica
Manager window.

You can also install Enterprise Edge Voice Applications Manager on any PC th
connected to the same Transmission Control Protocol/Internet Protocol (TCP
based local area network as the Enterprise Edge server.

Note: To record voice prompts or greetings using Enterprise Edge Voice 
Applications Manager from a PC, the PC must have voice recording 
capabilities, including a sound card, microphone and speakers.

Enterprise Edge Voice Applications Manager installation overview
To use this guide, you must be familiar with Enterprise Edge and Enterprise E
Voice Messaging terminology as well as the Windows® operating system.

PC prerequisites
Your PC must meet the following requirements before you install the Enterpri
Edge Voice Applications Manager client software:

• Your PC must be running Windows® 95, Windows® 98 or Windows® NT.

• If Enterprise Edge Voice Applications Manager is to be connected over a l
area network, your PC must be equipped with the required hardware and 
configured to access the same local area network the Enterprise Edge se
on.

• Your PC requires at least 2 MB of free disk space to install the Enterprise E
Voice Applications Manager client software.

• You must have installed DCOM95 for Windows 95 on your PC. If you do n
have DCOM95 installed, you can download it from the Microsoft website a
http://www.microsoft.com

2
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Installing the Enterprise Edge Voice Applications Manager client 
software

To install the Enterprise Edge Voice Applications Manager software:

1. Exit any Windows-based programs that are running.

2. On the taskbar, click the Start button, point to Find and then click 
Computer.
The Find: Computer dialog box appears.

3. In the Named list box, type the name of the Enterprise Edge server or sele
the Enterprise Edge server from the list. If you do not know the name, ask
your System Administrator.

4. Click the Find Now button.
The Enterprise Edge server icon appears in the list below.

5. Double-click the Enterprise Edge server icon.
The Enterprise Edge server window opens.

6. Double-click the NortelDT  folder.

7. Double-click the Enterprise Edge Voice Applications Manager folder.

8. Double-click the Setup.exe file.

9. Follow the instructions on the display to complete the installation.
Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide P0911620 Issue 02
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Starting the Enterprise Edge Voice Applications Manager client software 
from a PC

To start the Enterprise Edge Voice Applications Manager client software from
PC:

1. Click Start, point to Programs, point to Enterprise Edge Voice 
Applications Manager and then click Enterprise Edge Voice Applications 
Manager.
The Administration Password dialog box appears.

2. In the Server Name or IP Address box, type your Enterprise Edge server 
Name or IP Address.

3. In the Administration Password box, type your System Administrator 
Mailbox number and password combination and click the OK button.
For information on the System Administrator Mailbox number and passwo
combination refer to System Administrator and General Mailbox mailbox 
number and password combinations on page 65.

The Enterprise Edge Voice Applications Manager menu appears.
P0911620 Issue 02 Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide
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Removing the Enterprise Edge Voice Applications Manager client 
software

To remove the Enterprise Edge Voice Applications Manager client software f
your PC:

1. Click Start, point to Settings and then click Control Panel.
The Control Panel window appears.

2. Double-click Add/Remove Programs.

3. From the list, select Enterprise Edge Voice Applications Manager and click 
the Add/Remove button.
A message appears that asks you to confirm the deletion.

4. Click the Yes button.
The Uninstall program removes the items associated with Enterprise Edg
Voice Applications Manager. This procedure takes several seconds.

The Enterprise Edge Voice Applications Manager client software is now remo
from your PC.
Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide P0911620 Issue 02
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Setting up Enterprise Edge Voice Messaging

Overview
This chapter includes information about:

• Who can use Enterprise Edge Voice Messaging

• Using Enterprise Edge Voice Messaging with an Enterprise Edge two line
display telephone

• Ending a session

• Accessing your Personal Mailbox while away from the office

• Interrupting a voice prompt

• Recording prompts and greetings

Who can use Enterprise Edge Voice Messaging
Enterprise Edge Voice Messaging can be used by any outside caller and by m
owners in your company. Inside your office, Enterprise Edge Voice Messaging
be used from any touch tone phone connected to your Enterprise Edge syste
Mailbox owners who are away from the office can use Enterprise Edge Voice
Messaging can from any touch tone phone.

Incoming calls from a rotary dial telephone are transferred to your company 
Receptionist or designated Operator. If the Operator is not available, the calle
directed to the General Delivery Mailbox.

When using Enterprise Edge Voice Messaging from a Enterprise Edge telepho
mailbox owner must first enter a feature code. For more information about fea
codes, refer to Mailbox feature codes on page 99.

Using Enterprise Edge Voice Messaging with an Enterprise Edge two line 
display telephone

The display on Enterprise Edge two line display telephones provides informa
about commands and options available when you are using Enterprise Edge 
Messaging.

The display can show up to three display button options at once. In some insta
you must wait for the voice prompt to play the other available options. When 
options are played by the voice prompt and the corresponding button does no
appear on the display, you must select the option using the numbers on the d

The Enterprise Edge two line display display is shown in the figure Enterprise Edge 
two line display on page 26.

3
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Enterprise Edge two line display

Ending a session
To exit from a Enterprise Edge Voice Messaging session:

• hang up the handset

• or press ®

Accessing your Personal Mailbox while away from the office
When you are away from the office, you can access Enterprise Edge Voice 
Messaging from the dialpad of any touch tone telephone. To access your Per
Mailbox, press ••, or in the UK press °°, while your Personal Greeting 
plays. Enter your Personal Mailbox number and password combination and fo
the voice prompts.

After you listen to your messages, the messages you have not deleted are 
automatically saved.

A mailbox owner has a limited number of incorrect password attempts when tr
to open a Personal Mailbox while away from the office. The system disconnect
call after three incorrect attempts.

Interrupting a voice prompt
Each command shown on the telephone display is accompanied by a voice pr
On an Enterprise Edge two line display telephone, the voice prompt plays aft
five-second delay. If you do not select an option, the call is disconnected. On
Enterprise Edge one line display telephone, the voice prompt plays immediate
you do not select an option within an additional five seconds, the voice promp
replays the options before the session ends.

Enterprise Edge Voice Messaging voice prompts provide the same options a
display button options, and additional options not on the display. When the vo
prompt plays the available options, it announces the dialpad buttons that invok
options.

When the voice prompt announces a display option with a corresponding dia
button, you can use the display button or the number on the dialpad. Either b
invokes the selected option.

A user can stop a voice prompt by pressing £. A user cannot interrupt a prompt 
that is informing the user of an error.

A user can press • to return to the previous display prompt.

There are no voice prompts for configuration options. All configuration comma
and options appear on an Enterprise Edge two line display telephone.

Pswd:
OTHR RETRY OK

Display prompt
Display options

Display button
Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide P0911620 Issue 02
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Recording greetings and prompts
To record greetings and prompts, click the Voice button and record greetings
prompts from your PC or Enterprise Edge telephone, or locate previously reco
greetings and prompts.

The PC you use to record prompts and greetings must have a sound card, sp
and a microphone.

The telephone you use to record prompts and greetings must be a telephone o
Enterprise Edge system.

You can use your PC or Enterprise Edge telephone to record:

• Automated Attendant prompts and greetings.
See Recording a Company Greeting on page 35 and 
Recording a Custom Menu prompt on page 38.

• Mailbox prompts and greetings.
See Adding a Group List on page 94.

• CCR prompts and greetings.
See Beginning to build a new Tree on page 110
Adding a Menu sub-node on page 112 and
Adding an Information Mailbox on page 113.

Recording a greeting or prompt from your telephone handset

1. Click the Voice button.
The dialog box you can record greetings and prompts from appears.

2. In the Set is box, type the extension number of the Enterprise Edge telepho
you are using to record the greeting or prompt.

3. Click the Record button.
The telephone rings.

4. Pick up the handset. After the tone, record your greeting or prompt.

5. After you finish recording the greeting or prompt, click the Stop button.

6. To listen to the greeting or prompt, click the Play button.

7. Click the Close button and replace the telephone handset.
A message appears that asks you to confirm that you want to save the 
recording.

8. Click the Yes button to save the changes.
You return to the dialog box.

9. Record another greeting or prompt or click the Close button.
P0911620 Issue 02 Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide
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Recording a greeting or prompt from your PC
To record a greeting or prompt using Enterprise Edge Voice Applications Man
from a PC, the PC must have voice recording capabilities, including a sound 
microphone and speakers.

1. Click the Voice button.
The dialog box you can record greetings and prompts from appears.

2. At the PC Microphone and Speakers option, click the Record button.
The Sound Recorder dialog box appears.

3. Click the Record button to record the greeting or prompt.

4. After you finish recording the greeting or prompt, click the Stop button.

5. Click the Close button to close the Sound Recorder.
A message appears that asks you to confirm that you want to save the 
recorded file.

6. Click the Yes button on the next two dialog boxes to save the recording.

7. Click the Close button to return to the dialog box.

8. Click the OK  button to close the dialog box.

Locating a previously recorded greeting or prompt

1. Click the Voice button.
The dialog box you can locate the greeting or prompt from appears.

2. Click the Advanced button.
The dialog box expands to show the Upload Voice and Download Voice 
options.

3. If you know the location of the greeting or prompt, in the Load from File box 
type the location of the file and click the Load from  File button
or
if you do not know the location of the greeting or prompt, at the Upload 
Voice option, click the Browse button and follow steps 4 through 8.
The Open dialog box appears.

4. From the Look in  list, select the location of the file.

5. In the File name box, type the file name.

6. From the Files of type list, select the file type.

7. Click the Open button.

8. Click the Close button and then click the OK  button to accept the greeting or
prompt.
Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide P0911620 Issue 02



Section III - Automated Attendant
• Setting up an Automated Attendant

• Automated Attendant Status settings
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Setting up an Automated Attendant

Overview
The Automated Attendant provides a convenient means of answering your 
company’s incoming telephone lines with a prerecorded greeting selected from
Greeting Table, according to the time of day.

You can record and assign different greetings to the Greeting Tables. You can
specify which greeting plays for particular lines. For example, you can program
system so that callers hear one greeting when they call the sales line, and a di
greeting when they call the customer support line.

After the greeting, the Automated Attendant Menu offers callers a range of op
that they can select using the dialpad of their telephone. You can also customiz
menu to provide a different selection of options for callers.

If you want to offer a greater range of options and services for incoming calls,
can assign a Custom Call Routing (CCR) menu instead of the Automated Atten
Menu.

Automated Attendant answering overview

4

Incoming call

Voice Attendant

answersanswers
Receptionist

Company Greeting
plays

Custom Call Routing

Home Menu options play 

Voice Attendant
 Menu options play
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This chapter contains information and procedures on:

• recording your company Greetings

• setting up a Greeting Table

• assigning greetings to the table

• creating a custom menu

• adding an Alternate Language for your greetings

• assigning the Greeting Table Attendant

• assigning a Custom Call Routing menu

• programming the business hours for the Automated Attendant

• programming which lines are answered by Enterprise Edge Voice Messag

• setting the number of rings before Enterprise Edge Voice Messaging answ

You can revise the Automated Attendant settings to reflect changes in your o
This section also contains information on:

• viewing and changing which lines are answered by Enterprise Edge Voice
Messaging

• enabling or disabling the Touchtone Gate option

• enabling or disabling the Enterprise Edge Voice Messaging option

Other options available are explained elsewhere in this guide, such as changi
Company Directory status for a mailbox and adding or changing a Caller ID (CL
Dialing Table.

Greeting Tables
The Greeting Tables store the recordings played by the Automated Attendan
to incoming callers. Enterprise Edge Voice Messaging provides four Greeting
Tables numbered 1 to 4.

You can record a total of 40 Company Greetings, but only four greetings can
assigned a Greeting Table at any one time. You can assign the same four gre
to each table, or you can assign unique greetings to each table.
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The following shows an example of how Greetings can be assigned to the tab

We recommend using greetings 1 through 16 as your daily business greeting
greetings 17 through 40 as special greetings.

Each Greeting Table is divided into four sections, based on the time of day. T
following shows the default times assigned to the sections.

 

Greeting Tables using the Alternate Language

If you use a Primary and an Alternate Language, we recommend that you assig
Greeting Table to the Alternate Language. For example, if your company has
incoming lines and you want to assign a line to the Alternate Language, you m
assign the line to a Greeting Table that has all the greetings recorded in the Alte
Language. This means you can record greetings 5, 6, 7 and 8 in the Alternate
Language and assign the greetings to Greeting Table 2 for line 2.

Greeting Type Table 1 Table 2 Table 3 Table 4

Morning Greeting 1 Greeting 5 Greeting 9 Greeting 13

Afternoon Greeting 2 Greeting 6 Greeting 10 Greeting 14

Evening Greeting 3 Greeting 7 Greeting 11 Greeting 15

Non-business Greeting 4 Greeting 8 Greeting 12 Greeting 16

Greeting type Default start times

Morning 12:00 am

Afternoon 12:00 pm

Evening 6:00 pm

Non-business 6:00 pm

If default hours are used, the Non-business Greeting is not heard by 
caller.

The Non-business Greeting can be turned on and off using the Busin
Status feature.
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Company Greetings
Before you record your company Greetings, determine the type of greetings t
used on the different incoming telephone lines and what you want the greetin
say. You must prepare at least four greetings. As you record your greetings, nu
them from 1 to 4.

The four greetings reflect the Morning, Afternoon, Evening and Non-business
hours. For example:

1) Morning Greeting: “Good morning. You have reached Touchstone 
Marketing.”

2) Afternoon Greeting: “Good afternoon. You have reached Touchstone 
Marketing.”

3) Evening Greeting: “Good evening. You have reached Touchstone 
Marketing.”

4) Non-business Greeting: “You have reached Touchstone Marketing. Our 
business hours are Monday to Friday from 8:00 a.m. to 
5:00 p.m. Please stay on the line and leave a message. 
Thank you for calling.”

Greetings 1 through 4 are assigned by default to all Greeting Tables. This me
that Greeting 1 is played as the Morning Greeting for Greeting Tables 1, 2, 3 a

If you use only one Greeting Table, the numbered greetings you record from 1
play automatically. You do not have to assign Greetings 1 to 4 to the Table, bu
must select the language preference.

If you use a Primary and Alternate Language, it is a good idea to record the o
· instruction in the Alternate Language. For example, if you use English as 
Primary Language and French as your Alternate Language, your main greetin
English and the option · instruction is in French. For example:

“Good morning. This is Touchstone Marketing. To use our voice messaging
service in French, press ·.”

Since the default Automated Attendant Menu prompt does not announce an 
Alternate Language Option, your Greeting must instruct a caller to press · to use 
the Alternate Language.

Company Greetings can be 1 to 10 minutes in duration. If you need to chang
greeting duration, you must change the Class of Service assigned to the Sys
Administrator Mailbox. For information on how to change the setting, refer to 
Changing mailbox options on page 85.

After you determine what your Greetings are, practice recording them. Reme
to speak slowly and clearly, at a pace that is easy to understand.
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Recording a Company Greeting

To record a Company Greeting:

1. Click the Auto Attendant menu and then click Company Greetings.
The Company Greetings dialog box appears.

2. Click the number of the greeting you want to record.

3. Follow the steps in Recording a greeting or prompt from your telephone 
handset on page 27 to record a greeting from your telephone handset
or
follow the steps in Recording a greeting or prompt from your PC on page 28 
to record a greeting from your PC
or 
follow the steps in Locating a previously recorded greeting or prompt on page 
28 to select a previously recorded greeting.

Setting up a Greeting Table
To set up a Greeting Table, complete the following procedures to:

• assign a greeting and a CCR Tree to a Greeting Table

Note: You must build a Custom Call Routing (CCR) Tree before you can 
assign it.

• set your company’s Business Hours

• assign a language preference

• assign a Greeting Table Attendant

• record Custom Menu prompts, if you want to replace the default Automate
Attendant Menu.
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Assigning greetings and CCR Trees to Greeting Tables
For each Greeting Table you can assign what greeting plays and what CCR T
calls route to depending on the time of day. Assigning a CCR Tree to a Gree
Table is optional. You must build a CCR Tree before you can assign it.

If you do not assign a CCR Tree to a Greeting Table, the caller hears the gre
you assign and then hears the Automated Attendant menu prompt. If you ass
greeting and a CCR Tree to a Greeting Table, the caller hears the greeting yo
assign and is routed to a CCR Tree.

To assign greetings and CCR Trees to a Greeting Table:

1. Click the Auto Attendant menu, point to Greeting Table and click the 
number of the Greeting Table you want to configure.
The Greeting Table Setup dialog box appears with the Routing tab open.

2. At the Greeting option, in the Morning , Afternoon, Evening and Non-
business boxes, type the greeting numbers you want to use.

3. At the CCR Tree option, select from each list box the CCR Tree you want 
calls to route to for each time of day. If you do not want calls to route to a 
CCR Tree, select None from the list box.

4. Click the OK  button.

Setting the Business Hours
Setting the Business Hours determines when greetings and CCR Trees apply
Greeting Tables. Business Hours are divided into the categories of Morning, 
Afternoon, Evening and Non-business for each day of the week for each Gre
Table.

To set the Business Hours:

1. Click the Auto Attendant menu, point to Greeting Table and then click the 
Greeting Table you want to configure.
The Greeting Table Setup dialog box is displayed.

2. Click the Hours tab.

3. From the list box, select the day of the week you want to configure.

4. Use the arrows to select a start time in the Morning , Afternoon, Evening and 
Non-business boxes.

5. Click the OK  button.
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To set up the days when your business is not open, set the Non-business sta
to 12:00 a.m. Then set the Morning, Afternoon and Evening start times to 11:
p.m. so that the Non-business greeting plays throughout the day.

You can turn the Non-business greeting on or off using the Business Status fe
If you set the Business Status to off, the Non-business greeting continues to 
until you set the Business Status to on. For information on setting the Busine
Status, see Setting the Business Status on page 46 and Changing the Business Statu
from a remote telephone on page 48.

Assigning the language preference
When all your greetings are assigned to the Greeting Table, you can assign t
language preference. You can change the language preference at any time. Y
set the language preference for each Greeting Table. This setting determines 
language the Automated Attendant uses when answering incoming calls. If th
Enterprise Edge Voice Messaging Bilingual option is set to No, you do not as
a language preference.

To assign an language preference:

1. Click the Auto Attendant menu, point to Greeting Table and then click the 
Greeting Table you want to configure.
The Greeting Table Setup dialog box appears.

2. Click the Answering tab.

3. At the Language Preference option, select Primary  to use the Primary 
Language or select Alternate to use the Alternate Language.

4. Click the OK  button.

Assigning the Greeting Table Attendant
Assigning the Greeting Table Attendant overrides the designated Operator. If
Attendant does not answer, the call goes to the destination mailbox. If there i
mailbox, the call goes to the General Delivery Mailbox.

To assign the Greeting Table Attendant:

1. Click the Auto Attendant menu, point to Greeting Table and then click the 
Greeting Table you want to configure.
The Greeting Table Setup dialog box appears.

2. Click the Answering tab.

3. In the Attendant Extension box, type the extension of the Greeting Table 
Attendant.

4. Click the OK  button.
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Automated Attendant Menu
The Automated Attendant Menu plays after the company Greeting, and when
mailbox owner accesses the Automated Attendant.

The default Automated Attendant Menu informs the caller: “Using the dialpad, 
please enter the extension you wish to call. To use the directory, press £. To leave 
a message, press•. To reach an Operator, press ‚.”

Recording a Custom Menu prompt
If the Automated Attendant Menu prompt is set to No, you must record a Cus
Menu prompt to replace the prerecorded one. You can record a prompt from 
PC or your telephone handset, or you can select a previously recorded prom

When you record a Custom Menu prompt you can provide the caller with a lis
options such as choosing the Alternate Language, accessing the Company Dir
or reaching an Operator. Each Greeting Table has two Custom Menu prompts
Primary and Alternate prompt.

Remember to speak slowly and clearly, at a pace that is easy to understand.

To record a Custom Menu prompt:

1. Click the Auto Attendant menu, click Greeting Table and click the Greeting 
Table you want to record a prompt for.
The Greeting Table Setup dialog box appears.

2. Click the Answering tab.

3. At the Custom Auto Attendant Menu Prompts option, select the Enable 
check box.

4. Follow the steps in Recording a greeting or prompt from your telephone 
handset on page 27 to record a greeting from your telephone handset
or
follow the steps in Recording a greeting or prompt from your PC on page 28 
to record a greeting from your PC
or
follow the steps in Locating a previously recorded greeting or prompt on page 
28 to select a previously recorded greeting.
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Changing the Enterprise Edge Voice Messaging language availability
The Automated Attendant language is set when Enterprise Edge Voice Mess
is installed.

If you set the Enterprise Edge Voice Messaging bilingual option to No, there i
Alternate Language capability, and all the Classes of Service are assigned th
Primary Language selected. This means that a caller who presses · when using 
the Automated Attendant is told that the command is not recognized.

To change the Enterprise Edge Voice Messaging language availability and th
Primary and Alternate Languages:

1. Click the Options menu and then click System Parameters.
The System Parameters dialog box appears.

2. At the Bilingual  option, select Yes to enable the Alternate Language or sele
No to disable Alternate Language capability.

3. From the Primary Language list box, select the Primary Language you wan
to use.

4. From the Secondary Language list box, select the Secondary Language you
want to use. The Secondary Language cannot be the same as the Primar
Language.

5. Click the OK  button.

Programming which lines are answered by Enterprise Edge Voice 
Messaging

Enterprise Edge Voice Messaging is able to answer all of your incoming lines
just the lines you specify. Before Enterprise Edge Voice Messaging answers 
incoming line, you must assign the line and set the Answer status to Yes. The
maximum number of lines is 500.

You can assign Enterprise Edge Voice Messaging to answer incoming calls a
specified number of rings. The number of rings ranges from 0 (zero) to 12. If 
number of rings is left at zero, Enterprise Edge Voice Messaging answers 
immediately.

For lines equipped with Caller ID (CLID), you must assign the number of ring
two or more. CLID is not provided until just prior to the second ring, so assign
the number of rings to zero or one prevents CLID from being relayed. Withou
CLID, Personalized Greetings and other features related to CLID do not func
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Assigning a Greeting Table and the number of rings before Enterprise Edge 
Voice Messaging answers

1. Click the Auto Attendant menu, and then click Lines.
The Line Administration dialog box appears.

2. Click the line number you want to configure.

3. Click the Change button.

4. At the Answer option, select AA .

5. In the Table Number box, type the Greeting Table number you want to 
assign to the line selected.

6. In the Number of Rings box, type the number of rings before Enterprise Ed
Voice Messaging answers.

7. Click the OK  button.
Repeat steps 3 through 7 for each line you want to configure.

8. Click the Close button.
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Enabling Touchtone Gate
The Touchtone Gate option allows you to speed up routing incoming calls.

When you enable Touchtone Gate, you can choose to have the standard voic
prompt play or you can record your own custom prompt. If you choose the stan
prompt, the following voice prompt plays after your company greeting: “If you are 
calling from a touch tone phone, please press ⁄ now. If you are a rotary caller, 
please hold and you will be transferred.” 

Note: If you want to use a custom voice prompt, you must record it before 
enabling Touchtone Gate. It is recommended that you use Greeting 40 a
custom Touchtone Gate voice prompt. When you enable Touchtone G
Greeting 40 is the default custom voice prompt. For more information 
recording Greetings, refer to Recording a Company Greeting on page 35.

If the caller presses ⁄ on the telephone dialpad, the call proceeds to the Automa
Attendant or CCR Tree. If no tone is received, the call is sent back to the 
Receptionist or designated Operator specified by the Greeting Table. If the 
attendant is not available, the call is directed to the General Delivery Mailbox
this is not available, the call is disconnected.

The Touchtone Gate voice prompt is not presented to internal callers or while u
Feature 981 or Feature 986.

If you disable Touchtone Gate re-record the Company Greeting to include “If you 
are calling from a touch tone phone, please dial the extension or press £ for the 
company directory. If not, please hold and you will be transferred to the opera

To enable or disable Touchtone Gate:

1. Click the Auto Attendant menu and then click General AA Parameters.
The General Auto Attendant Parameters dialog box appears.

2. At the Touchtone Gate option:
select None to disable Touchtone Gate
or
select Standard to enable the default prompt
or
select Custom and enter the number of the customized prompt.

3. Click the OK  button.
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Setting up the fax answering extension
This feature allows a caller to use the autosend feature on their fax machine to
faxes to the Enterprise Edge Voice Messaging system. The Automated Atten
recognizes the fax tone and automatically sends the fax messages to the fax
answering extension fax machine for printing. The fax answering extension mu
a valid Enterprise Edge extension. The fax answering extension is empty by de

Note: The fax answering extension fax machine must be connected to an 
Enterprise Edge ATA 2 or an Analog Station Module.

To assign a fax answering extension:

1. Click the Fax menu.
The Fax Parameters dialog box appears.

2. In the System Fax Extension box, type the fax answering extension.

3. Click the OK  button.

Enabling and disabling Enterprise Edge Voice Messaging
You can enable or disable Enterprise Edge Voice Messaging at any time. Th
default status is enabled. If Enterprise Edge Voice Messaging is enabled, cal
who try to reach an extension that is busy or does not answer are transferred
extension’s mailbox. Callers can access all mailboxes when Enterprise Edge V
Messaging is enabled.

If Enterprise Edge Voice Messaging is disabled, callers hear the Automated 
Attendant Menu prompt. Callers cannot leave messages in any mailboxes bu
access Information Mailboxes, or press ‚ to reach the Operator.

If the Enterprise Edge Voice Messaging Option is disabled, Enterprise Edge V
Messaging users can still leave a message in a mailbox using Feature 980, as
in the figure Overview of Sending Messages using Feature 980 on page 43, or the 
record message option in Feature 981. The mailbox owner can also transfer in
calls to another mailbox using Feature 986.
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Overview of Sending Messages using Feature 980

To enable or disable Enterprise Edge Voice Messaging:

1. Click the Options menu and then click System Parameters.
The System Parameters dialog box appears.

2. At the Voice Mail option, select Enable or Disable.

3. Click the OK  button.

Feature 980

Enter
mailbox
number

     Use 
Directory

Owner’s 
name
confirmation

Record 
message

Send
message

Delivery Options
          (3)

Certified Urgent

Private Timed

Other
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Automated Attendant Status settings

Overview
This chapter describes how to:

• set the Operator Status to Yes or No

• change the Operator password

• set the Business Status

• assign Enterprise Edge Voice Messaging Line answering

• change the Automated Attendant Status

Setting the Operator Status
When your company Receptionist or Operator is available to respond to caller
the Operator Status to Yes. When your company Receptionist or designated 
Operator goes for a break, lunch, or leaves in the afternoon, set the Operator 
to No.

If the Operator Status is set to No, a caller who requests an Operator is informe
Operator is not available, and is transferred to the Menu options to dial anoth
extension or leave a message.

To set the Operator Status:

1. Click the Options menu and then click Operator Settings.
The Operator Settings dialog box appears.

2. At the Attendant Available option, select Yes if the Operator is available or 
select No if the Operator is not available.

3. Click the OK  button.

Changing the Operator password
The Operator password can be reset to the default at any time. The default Op
password is fl‡‹‡¤°fl‡ (Operator).

To change the Operator password:

1. Click the Options menu and then click Operator Settings.
The Operator Settings dialog box appears.

2. Select the Reset Operator Password check box.

3. Click the OK  button in the next two dialog boxes to accept your changes.

5
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Changing the Operator default extension
Whenever anyone selects the option of speaking to your company Reception
Operator, Enterprise Edge Voice Messaging transfers the call to the Operato
extension. For example, if Enterprise Edge Voice Messaging is operating on a
digit Enterprise Edge extension length, this extension is 21. You can change 
Receptionist or designated Operator extension.

If the Operator’s extension changes, you must change the extension of the G
Delivery Mailbox to the new extension of the Operator.

Callers can request to speak to your company Receptionist or designated Op
when the Automated Attendant voice prompt announces the option and the 
Operator Status is set to Yes.

To change the Operator default extension:

1. Click the Options menu and then click Operator Settings.
The Operator Settings dialog box appears.

2. In the Attendant box, type the Operator’s extension number.

3. Click the OK  button.

Anyone requesting an Operator is transferred to the new extension. If the Ope
does not answer, the call is transferred to the General Delivery Mailbox.

Setting the Business Status
The Business Status setting overrides the scheduled times programmed for t
Morning, Afternoon, and Evening in the Greeting Tables.

If the Business Status is set to Yes, greetings are played according to the tim
scheduled in the Greeting Tables. For example, if Business Status is set to Ye
Morning, Afternoon and Evening Greetings play automatically according to th
start times programmed in the Greeting Tables.

When the Receptionist sets the Business Status to No at the end of the busine
or prior to the weekend, the Non-business hours Greeting continues to play un
Business Status is set to Yes.

Have the company Receptionist or designated Operator change the Business
to Yes in the morning when your company opens. At the end of the business
have the company Receptionist or designated Operator set the Business Sta
No.
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To set the Business Status:

1. Click the Options menu and then click Operator Settings.
The Operator Settings dialog box appears.

2. At the Business Open option, select Yes to return to the Greeting Table 
settings or select No to override the Greeting Table and play the Non-busine
greeting.

3. Click the OK  button.

Making changes from a remote telephone
You can access Enterprise Edge Voice Messaging to change a greeting or th
Business Status by using the dialpad of any internal or external touch tone ph
Remote administration must be done through the System Administrator Mailb
The System Administrator Mailbox must be initialized before remote 
administration can be accessed.

To access the System Administrator Mailbox:

1. While the greeting plays, press ••, or in the UK press °°.

2. Enter the System Administrator Mailbox number and password combinati

3. Press £.

4. Press ·· to access the Remote Administration Menu.

From the Remote Administration Menu, you can change a greeting, or assign
Business Status to open or closed.
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Changing the Business Status from a remote telephone
If the Business Status is No (office is closed) and you wish to set it to Yes (offi
open), start from the Remote Administration Menu:

The following voice prompts play:

“To open or close the business, press ⁄.”
“To change a Company Greeting, press ¤.”
“To exit, press •.”

1. Press ⁄.

The following voice prompts play:

“The business is closed.”
“To open it, press ⁄.”
“To exit, press •.”

2. Press ⁄.

The following voice prompts play:

“The business is open.”
“To close it, press ⁄.”
“To exit, press •.”

3. Press •.

The Business Status is now set to open.

If the Business Status is set to open and you wish to set it to closed, start from
Remote Administration Menu and follow the voice prompts.

Changing a Company Greeting from a remote telephone
To change a greeting that has been assigned to a Greeting Table, start from 
Remote Administration Menu. 

The following voice prompts play:

“To open or close the business, press ⁄.”
“To change a Company Greeting, press ¤.”
“To exit, press •.”

1. Press ¤.

2. Enter the number of the greeting (from 1 to 40) you wish to change.
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3. Press £ to accept the greeting number.
To listen to the greeting, press ¤. 
If you want to access a different greeting number, press • and enter the new 
number.

4. Press ⁄ to record your new greeting.

5. After the tone, record your greeting.

6. Press £ to end your recording.
Press ⁄ to replay your recording.
To erase and re-record your greeting, press ¤.

7. Press £ to accept your recording.

After the recording is accepted you return to the Remote Administration Menu

Setting the Answer Lines status
Enterprise Edge Voice Messaging can answer all your Central Office (CO) lin
included in line configuration. When Answer Lines is enabled, Enterprise Edg
Voice Messaging answers all incoming calls and presents each caller with th
Company Greeting and Automated Attendant Menu. You can designate wheth
not Enterprise Edge Voice Messaging answers your company lines. When An
Lines is disabled, Enterprise Edge Voice Messaging does not answer incomi
calls. All incoming calls must be answered and routed by your company 
Receptionist.

For more information about line configuration, refer to Programming which lines 
are answered by Enterprise Edge Voice Messaging on page 39.

To assign Answer Lines:

1. Click the Options menu and then click Operator Settings.
The Operator Settings dialog box appears.

2. At the Answer Lines option, select Yes to have your lines answered by 
Enterprise Edge Voice Messaging or select No to have the call answered by 
the company Receptionist.

3. Click the OK  button.
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Setting the Return to Automated Attendant Status
The Automated Attendant Menu plays after the Company Greeting and also a
caller leaves a message in a mailbox. The Automated Attendant Menu provid
caller with a list of options, such as entering a mailbox number, accessing the
Company Directory or reaching the Operator. You can turn the default Autom
Attendant Menu off at any time and record a customized menu prompt. For m
information about recording customized menu prompts, refer to Company 
Greetings on page 34.

When the Return to Automated Attendant prompt is set to No, the caller is no
provided with any more options after leaving a message. Instead, after hearin
voice prompt “Message delivered”, the caller hears “Exiting the system, good-
bye”, and the session ends.

To change the Automated Attendant status:

1. Click the Auto Attendant menu and then click General AA Parameters.
The General Auto Attendant Parameters dialog box appears.

2. To enable the Automated Attendant menu, select the Return to AA  check 
box. To disable the Automated Attendant menu, clear the Return to AA  
check box.

3. Click the OK  button.
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Section IV - Mailboxes
• Overview of Mailboxes

• Special Mailboxes: General Delivery and System Administrator
• Creating Mailboxes

• Changing and Deleting Mailboxes

• Mailbox Administration Tasks
• Mailbox feature codes
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Overview of Mailboxes

A mailbox is a storage place for fax and voice messages on the Enterprise E
Voice Messaging system. This section contains information about creating an
managing the different types of mailboxes. For information about fax, refer to
Enterprise Edge 2.0 Voice Messaging FAX Set Up and Operation Guide and the 
Enterprise Edge 2.0 Voice Messaging FAX User Guide.

Mailboxes are installed by enabling a Mailbox Software Keycode on the Enterp
Edge server. The Mailbox Software Keycode limits the number of Subscriber
mailboxes that can be added to Enterprise Edge Voice Messaging. For exam
you enable a 16 Mailbox Software Keycode, you can have a maximum of 16 
Subscriber mailboxes on the Enterprise Edge server. If you need more than 1
Subscriber mailboxes, you must purchase another Mailbox Software Keycode
can have a maximum of Subscriber 1,000 mailboxes on the Enterprise Edge s

Types of mailboxes
Mailboxes are added in any combination of the following:

• Special Mailboxes, which include System Administrator and General Deliv
Mailboxes

• Personal Mailboxes, which include User and Guest Mailboxes

• Information Mailboxes

System Administrator Mailbox
The System Administrator Mailbox is created automatically when the Enterpr
Edge Voice Messaging system is installed for the first time. In order to use it,
mailbox must be initialized by changing the password and recording the nam

Until a mailbox is installed, it cannot receive voice messages and any calls tha
directed to it are rerouted to the General Delivery Mailbox.

Only a person using the System Administrator mailbox and password has the a
to create, change, or delete the mailboxes. Administrative tasks are also perfo
using the System Administrator Mailbox.

For more information, refer to the following chapters:

• Special Mailboxes: General Delivery and System Administrator on page 63

• Creating Mailboxes on page 77

• Changing and Deleting Mailboxes on page 85

• Mailbox feature codes on page 99

6
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General Delivery Mailbox
The General Delivery Mailbox is created automatically when the Enterprise E
Voice Messaging system is initialized for the first time. This is the company 
mailbox and, like the System Administrator Mailbox, you initialize the Genera
Delivery Mailbox by changing the password and recording the name.

For more information, refer to Special Mailboxes: General Delivery and System
Administrator on page 63.

User Mailboxes
The User Mailbox is the first of three types of mailboxes that can be created b
System Administrator. It must be initialized by the mailbox owner before it ca
receive messages. The Create Mailbox Utility is useful if you need to create se
User Mailboxes with the same values. For more information, refer to Creating 
Mailboxes on page 77.

Guest Mailboxes
The Guest Mailbox is the second type of mailbox that can be created by the Sy
Administrator. This type of mailbox is assigned to users who do not have an 
operating extension, but require a mailbox. It must be initialized by the mailbo
owner before it can receive messages. For more information, refer to Guest 
Mailboxes on page 80.

Information Mailboxes
The Information Mailbox is the third type of mailbox that can be created by th
System Administrator. This mailbox plays an information message to callers.
must be initialized before it can play an information messages to callers. Call
cannot leave messages in an Information Mailbox. For more information, refe
Information Mailboxes on page 83.

Tools and materials
Before you begin adding mailboxes, complete the Mailboxes section of the 
Enterprise Edge 2.0 Voice Messaging Programming Record. This enables you to 
enter the values and become familiar with the task without having to stop and
review each feature, especially when you are adding the first few mailboxes.
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Terms and definitions
The following terms are introduced in this section:

Term Definition

Alternate sets If a caller dials a set that has one or more alternate extensions, Enterprise E
Voice Messaging rings at all of the sets simultaneously. The first set to answ
accepts the call. The other sets cannot access the line or use the Interrupt Fe
(Feature 987) to access the answered line.

Alternate extensions are available only on User mailboxes.

Call Screening If you change a mailbox owner’s Personal Mailbox transfer option to Screen
the Call Screening feature lets the mailbox owner listen to a recording of the 
caller’s name before accepting the call.

Class of Service A Class of Service defines the values for the special features of a Mailbox. W
you set up a mailbox, you can assign several special features at once by assi
a Class of Service that provides an appropriate level of service for the user.

A mailbox cannot be added without a Class of Service.

Company Directory The Company Directory is an internal voice list that contains the names of 
mailbox owners with initialized mailboxes who are designated to appear in th
directory.

Guest Mailbox A Guest Mailbox is a type of Personal Mailbox assigned to people who do n
have a permanent extension, but require a mailbox. These mailboxes receive
store messages the same way that User Mailboxes do.

Information Mailbox An Information Mailbox plays an information message to callers. The 
Information Mailbox does not have an extension associated with it. Callers 
cannot leave messages in an Information Mailbox.

Mailbox A User Mailbox.

Message Waiting 
Notification

If a mailbox owner has a message, Message Waiting Notification displays 
Message for you on the display of the mailbox owner’s telephone.

Operator An Operator is the person whose extension rings when the caller is prompte
the Automated Attendant to “Press 0 for an operator”.

If the Operator is not available, calls transfer to the General Delivery Mailbox

In the Class of Service, the Operator is also known as the Target Attendant.

Outdial route The outdial route determines which line, line pool or route code the system 
for Off-premise Message Notification, Outbound Transfer or when a mailbox 
owner replies to a message left by an external caller.

Personal Mailboxes Personal Mailboxes (shown on telephone display as subscriber)

- include both User Mailboxes and Guest Mailboxes

- are assigned by the System Administrator and maintained by the mailbox ow

- can be listed in the Company Directory under the mailbox owner’s name

- are protected by a password that can be changed by the mailbox owner, or 
to 0000 by the System Administrator if the password is forgotten.

Subscriber When creating new mailboxes, the choices are Subscriber (which is a Gues
User mailbox) or Information.

User Mailboxes User Mailboxes store the messages for mailbox owners who are unable to a
their telephones.

User Mailboxes can be assigned to anyone who has an Enterprise Edge 
extension.
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Class of Service
Class of Service (COS) reduces the amount of programming needed to regis
mailbox. Instead of entering separate values for several special features, you
select a COS that contains the appropriate values for the new mailbox. You e
the COS during the mailbox registration and the system automatically program
associated values.

The following features have preset values. You can change individual values
meet the needs of your company. For more information on editing the values
Class of Service, refer to Enterprise Edge Voice Applications Manager online H

The features that are set by the Class of Service number are:

Features Explanation

Mailbox message time The total message time available to a mailbox. The maximum message time
minutes. An Enterprise Edge Voice Messaging mailbox is equipped with the 
Never Full Mailbox feature, which allows a caller to leave a message in a mailb
even if the mailbox is “full”. The message is stored in the mailbox, but cannot 
played, copied or saved until a saved message is deleted to create space in th
mailbox for the message.

Message length The maximum length of an incoming message. The message length ranges
one to 60 minutes.

Message retention 
period

The number of days messages are saved in a mailbox. The message retentio
period ranges from one to 365 days. 0 = indefinitely.

Greeting length The length of a recorded mailbox greeting. A mailbox greeting length can be
between 1 and 60 minutes.

Off-premise Message 
Notification

Directs messages to another Enterprise Edge set, any phone number, or a pa
For important information on preventing callers from making unauthorized 
external calls, refer to User Mailboxes on page 77. Dialing restrictions that apply 
to outdial lines apply to Off-premise Message Notification.

Retry intervals The time between attempts to notify the recipient of a new or urgent message
retry interval ranges from one to 120 minutes.

Number of attempts How many attempts Enterprise Edge Voice Messaging makes to notify the 
recipient of a new or urgent message. The number of attempts ranges from on
20.

Outbound Transfer Transfers a caller who reaches a mailbox and presses ‡ to an external phone 
number or an Enterprise Edge set.

Incorrect password 
attempts

The maximum number of incorrect password attempts before a mailbox user i
locked out of the mailbox. The incorrect password attempts range from one to

Password Expiry The maximum time a mailbox password is active. The password expiry rang
from one to 365 days. 0 = never expire.

Networking If Audio Messaging Interchange Specification (AMIS) or Digital Networking is
installed, voice messaging can be directed to different mailboxes located at 
various sites on a communication network.
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Default values
The following tables shows the default values for the Enterprise Edge Voice 
Messaging Classes of Service.

* If optional Message Networking is enabled.
 0 = indefinite; never expire, P = Primary Language, A = Alternate Language

Target Attendant The Target Attendant is assigned to answer a telephone when the caller rea
mailbox and presses ‚ to speak with the Operator.

Call Record Call Record lets users record an active telephone call and put the message i
mailbox. Call Record is activated by pressing ƒ·°·.

Call Record is not enabled in any Class of Service because it is prohibited by 
in some areas. If Call Record is legal in your area, use Enterprise Edge Voice
Applications Manager to customize a Class of Service to enable Call Record.

Class of Service 1 2 3 4 5 6 7 8

Prompt language P A P A P A P A

Mailbox message time (in minutes) 15 15 15 15 5 5 20 20

Message length (in minutes) 3 3 7 7 3 3 2 2

Message retention period (in days) 30 30 0 0 7 7 15 15

Greeting length (in minutes) 1 1 1 1 1 1 10 10

Off-premise Message Notification Y Y Y Y N N Y Y

Retry intervals (in minutes) 5 5 10 10 n/a n/a 30 30

Number of attempts 3 3 5 5 n/a n/a 9 9

Outbound Transfer Y Y Y Y N N Y Y

Incorrect password attempts 9 9 9 9 6 6 4 4

Password expiry (in days) 90 90 90 90 60 60 30 30

Message Networking* Y Y Y Y N N Y Y

Target Attendant Y Y Y Y N N Y Y

Call Record N N N N N N N N

Features Explanation
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 0 = indefinite; never expire P = Primary Language, A = Alternate Language
* If optional Message Networking is enabled.
 0 = indefinite; never expire, P = Primary Language, A = Alternate Language

The Class of Service determines how the available message time is distribute
among the mailboxes. The amount of time available to be distributed depend
the amount of message storage available on the Enterprise Edge Voice Mess
system. You can change the Class of Service values using Enterprise Edge V
Applications Manager.

Mailbox Overrides
Mailbox Overrides let you change these mailbox settings:

• Company Directory

• Alternate extensions

• Call Screening 

• Message Waiting Notification

• Outdial route

Mailbox Overrides are not included in a Class of Service. When you add a mai
you can change these settings without changing the Class of Service.

Class of Service 9 10 11 12 13 14 15 16

Prompt language P A P A P A P A

Mailbox message time (in minutes) 10 10 30 30 120 120 120 120

Message length (in minutes) 3 3 7 7 10 10 2 2

Message retention period (in days) 365 365 60 60 90 90 45 45

Greeting length (in minutes) 1 1 2 2 3 3 5 5

Off-premise Message Notification Y Y N N Y Y Y Y

Retry intervals (in minutes) 5 5 n/a n/a 15 15 30 30

Number of attempts 3 3 n/a n/a 7 7 9 9

Outbound Transfer Y Y N N Y Y Y Y

Incorrect password attempts 9 9 9 9 6 6 4 4

Password expiry (in days) 90 90 90 90 60 60 30 30

Message Networking* Y Y N N Y Y Y Y

Target Attendant Y Y N N Y Y Y Y

Call Record N N N N N N N N
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Company Directory
The Company Directory is an internal voice list that contains the names of ma
owners with initialized mailboxes who are assigned to the directory.

When you register a mailbox you determine whether the mailbox appears in t
Company Directory. The Company Directory override can be changed at any 
Company Directory options determine whether callers can search for names b
name, first name, or first and last names. For example, if a caller enters James
mailbox owner names Jesse James and James Bond come up if the Compan
Directory options are set for both first and last names.

The Company Directory option default is Yes. If you set the Company Directo
option is set to No, a mailbox owner’s name is not included in the Company 
Directory and a mailbox owner cannot be selected from the Company Directo
Even if a mailbox is not included in the Company Directory, the mailbox owne
must record their name when they initialize their mailbox.

For more information about the Company Directory, refer to Setting Up for a 
medium sized company on page 148.

Alternate extensions
Up to two Alternate extensions can be assigned to each User Mailbox. If a ca
dials the main extension (the extension that has Alternate extensions assigne
call rings at the main extension only. The exception to this is when Alternate 
extensions are assigned an Answer extension for the main extension. For mo
information about Answer Extension Numbers, refer to the Enterprise Edge 2.0 
Installation and Maintenance Guide included with Enterprise Edge.

When a caller leaves a message, a message waiting indicator appears at the
extension and at the Alternate extension(s). Mailbox owners can access the me
from the Alternate extension(s) with Feature 981, the same way they access 
messages from their main extension telephone.

If an Alternate extension is assigned to a telephone that has Caller ID and if Di
Caller is enabled, Caller ID information is displayed and an audible tone occu
all telephones when the call proceeds to Enterprise Edge Voice Messaging. T
message can be intercepted using Feature 987, the Interrupt feature, at the Al
extension as long as the caller is still leaving a message.

Only extensions that do not have a mailbox assigned can be used as an Alte
extension.

There are no default Alternate extensions programmed for User Mailboxes.
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Express Messaging Line
When you create a Subscriber Mailbox, you can assign an Express Messagin
to it. When you create the Subscriber Mailbox, instead of assigning an extens
number to it, assign an Express Messaging Line. If you assign an Express 
Messaging Line, fax and voice calls are left in the Subscriber Mailbox without
ringing at the set. When Message for you appears on the telephone display, the
user can open their mailbox and access their voice and fax messages.

If the user has FAX enabled, they can tell people that the Express Messaging
number is their fax number and they can have it printed on their business car

The line used you use for Express Messaging must be between 1 and 500. G
corresponding seven digit phone number associated with the line you assign 
Express Messaging Line to the user. For example, if line 20 is the Express 
Messaging Line and the corresponding phone number is 555-2424, give this p
number to the user. After you assign a line to a mailbox, you cannot assign th
to another function until you remove it from the mailbox.

The prime set for the Express Messaging Line must be set to the Voice Mess
DN. For more information see "Line Access" in the Enterprise Edge 2.0 
Programming Operations Guide.

The Express Messaging default is none. Users must have FAX enabled to re
fax messages on the Express Messaging Line.

Call Screening
Call Screening lets mailbox owners determine who is calling before they acce
call. Call Screening is useful if there is no Caller ID available. Enterprise Edg
Voice Messaging records the caller’s name, calls the mailbox owner’s telepho
announces the name of the caller and offers options such as accept the call o
a message.

Call Screening applies to external calls dialed by callers using the extension d
facilities of the Auto Attendant or Custom Call Routing (CCR). Call Screening d
not apply to internal calls, or external calls routed using a CCR Transfer node
placed to the mailbox owner’s dedicated line. If a caller is calling from a line f
which the mailbox owner has recorded a Personalized Greeting, Call Screen
bypassed and the call is transfers without delay.

If Call Screening is enabled, Enterprise Edge Voice Messaging still calls a ma
owner’s telephone that is call forwarded.

The default for Call Screening is No, which means that mailbox owners cann
determine who is calling before they answer the call.

Message Waiting Notification
Message Waiting Notification provides the user with a visual indication on the
telephone display that one or more new messages are waiting to be heard.
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The default value for Message Waiting Notification is Yes. This means that 
Enterprise Edge Voice Messaging leaves a Message for you notification on a 
Enterprise Edge telephone display. If the Message Waiting Notification is chan
to No, Enterprise Edge Voice Messaging does not leave a Message for you 
notification.

When you add Guest Mailboxes, you must set the Message Waiting Notificatio
No. These mailboxes do not have an operating Enterprise Edge extension. If
add a Guest Mailbox to a single-line telephone, you must set the Message 
Notification to No at the Enterprise Edge ATA 2. Single-line telephones do not h
a display.

Outdial route
The Outdial route determines which line, line pool or route code the system u
when a mailbox owner wishes to reply to a message left by an external caller
when Off-premise Message Notification and Outbound Transfer are used.

The default for Outdial route is None. Until you assign a line, line pool or route c
as the Outdial route for a mailbox, the mailbox owner can use the Reply Featu
reply to calls from internal extensions only, Off-premise Message Notification
internal extensions only and Outbound Transfer for internal extensions only.

For more information on line pools and route codes, refer to the Enterprise Edge 
2.0 Programming Operations Guide.

Dialing restrictions

Dialing restrictions can be applied to an Enterprise Edge telephone and the 
extensions connected to Enterprise Edge Voice Messaging. If you wish to res
outdialing of certain phone numbers, you must do one of the following:

• Through Enterprise Edge programming, assign the dialing restrictions to t
Enterprise Edge extension numbers to which Enterprise Edge Voice Mess
is connected. This restricts all outdialing calls including external transfers f
CCR trees, Off-premise Message Notification and Outbound Transfers. W
assigning an Outdial route, all dialing is done by the set to which Enterpris
Edge Voice Messaging is connected, not by the Enterprise Edge telephon
Refer to your Enterprise Edge System documentation for additional 
information.

• Through Enterprise Edge programming, assign the dialing restrictions to th
of the user. Refer to your Enterprise Edge System documentation for addit
information.

• Through Enterprise Edge programming, assign the dialing restrictions to t
Enterprise Edge line(s) being used for outdialing. Refer to your Enterprise E
System documentation for additional information.

• Through Mailbox Admin, ensure Outdial is set to NONE. This restricts outdialing 
calls from the mailbox.
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Special Mailboxes: General Delivery and 
System Administrator

Overview
Special Mailboxes are the administration tools of the System Administrator an
include:

• System Administrator Mailbox

• General Delivery Mailbox

 Overview of Programming using Feature 981: Open Mailbox

The first time a mailbox owner opens their mailbox, they must initialize the mail
by entering a password and recording a name in the Company Directory.

The Special Mailboxes are protected by a password that you establish. The 
password for each mailbox is determined when you initialize the mailbox with
Enterprise Edge Voice Messaging. For more information about mailbox passw
refer to About mailbox passwords on page 88.
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System Administrator Mailbox
The System Administrator Mailbox is reserved for the System Administrator. Y
can use it to send Broadcast Messages to all User Mailboxes.

Only you, as System Administrator, are able to access the System Administra
mailbox. Remember to check for messages sent to this mailbox.

You must initialize the System Administrator Mailbox before you can use it. F
instructions on how to initialize the System Administrator Mailbox see Initializing 
the mailboxes on page 65.

The mailbox numbers used in this guide for the Special Mailboxes are the 
Enterprise Edge Voice Messaging default mailbox numbers based on a two d
extension length. The mailbox number length is determined in the initial syste
setup. Mailbox numbers can be between two and seven digits. For informatio
about the System Administrator mailbox number see Special Mailbox numbers on 
page 65.

General Delivery Mailbox
The General Delivery Mailbox is your company mailbox. Messages can be left
for:

• employees who do not have their own mailbox

• no specific person

To ensure confidentiality, make sure that only you, the Receptionist, or a desig
Operator has the password for this mailbox.

The General Delivery Mailbox stores messages from callers when the Opera
not available or from callers using a rotary dial telephone. The General Delive
Mailbox has a default greeting, but you can replace this greeting with one you
record. For more information, refer to Recording the mailbox greeting on page 68 
in this section.

Messages left in the General Delivery Mailbox must be forwarded to the 
appropriate person. Only you, the Receptionist or a designated Operator can a
the messages in the General Delivery Mailbox.

We recommend assigning the General Delivery Mailbox number to the design
Operator. For more information, refer to Setting up the Operator’s Mailbox on page 
91. For information on the General Delivery Mailbox number refer to Special 
Mailbox numbers on page 65.

You can disable the General Delivery Mailbox if your company does not require
service of this mailbox. For more information, refer to Enabling and disabling the 
General Delivery Mailbox on page 90.
Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide P0911620 Issue 02



Special Mailboxes: General Delivery and System Administrator  65

ber 
x 
 The 
table 

o 
e 

n two 

 
e 

ial 
nd 
oth 

e 
 are 
Special Mailbox numbers

Mailbox number lengths can be from two to seven digits. When the mailbox num
length is two digits the System Administrator Mailbox is 12. When the mailbo
number length is seven digits, the System Administrator Mailbox is 1000002.
System Administrator password and mailbox combinations are shown in the 
System Administrator and General Mailbox mailbox number and password 
combinations.

Note: If the extension length is 2 and the leading digit for Group Lists (used t
send a message to a group of mailboxes) is 1, the default values for th
Special Mailboxes are 20 and 22. The extension length can be betwee
and seven digits.

Classes of Service for Special Mailboxes
The General Delivery Mailbox has a default Class of Service of 1. The System
Administrator Mailbox has a default Class of Service of 7. You can change th
Class of Service at any time. For more information, refer to Changing mailbox 
options on page 85.

Setting up the System Administrator and General Delivery Mailboxes

Opening the mailboxes
To open a Special Mailbox, you must enter the mailbox number and the Spec
Mailbox password. The default System Administrator Mailbox number is 12 a
the default General Delivery Mailbox number is 10. The default password for b
mailboxes is 0000.

Initializing the mailboxes
Before any Enterprise Edge Voice Messaging mailbox can be used, it must b
initialized. The steps for initializing Special Mailboxes and Personal Mailboxes
the same. Initializing a mailbox involves:

• changing the default password

• recording the mailbox name in the Company Directory

System Administrator and General Mailbox mailbox number and password combinations

Mailbox 
number length

System Administrator General Delivery

2 120000 100000

3 1020000 1000000

4 10020000 10000000

5 100020000 100000000

6 1000020000 1000000000

7 10000020000 10000000000
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Record a mailbox greeting as soon as possible after initialization.

The General Delivery Mailbox can receive messages before it is initialized, b
must be initialized before you can retrieve any messages from it.

Before you initialize a mailbox, decide what password you want to use to ope
mailbox. Passwords must be four to eight digits long and cannot start with ze
Write the passwords down and keep them in a safe place. Give the General De
Mailbox password to your Receptionist or designated Operator.

Recording the mailbox in the Company Directory
The Company Directory stores a list of mailbox owners in your company. Befo
mailbox can receive messages, the mailbox owner’s name must be recorded
Company Directory. Whether a mailbox appears in the Company Directory is
determined by the Company Directory override that you establish.
Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide P0911620 Issue 02



Special Mailboxes: General Delivery and System Administrator  67
To initialize the mailboxes:

After you record the Company Directory name, you return to the mailbox’s 
administration display prompt. You can now record the mailbox greeting.

You must repeat steps 1 through 6 to initialize each mailbox.

1. Press ƒ·°⁄.

2. Enter the System Administrator Mailbox 
number and password, then press OK.

If the set you are using has a mailbox, the  
Pswd: prompt appears. Press OTHR to display 
the  Log: prompt.

3. Enter the new password and press OK.

4. Enter the new password again and press OK.

5. At the tone, record your name and press  OK.

When you record a mailbox name in the 
Company Directory, include the directory 
number.

6. To accept the recording, press  OK.

If the recording is not acceptable, press  
RETRY.

Press ® to end this programming session.

Log:
QUIT        RETRY         OK

Must change pswd

Pswd:
RETRY                         OK

Again:
RETRY                         OK

Must record name

Record name:
RETRY                         OK

Accept name?
RETRY         PLAY        OK
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Recording the mailbox greeting
You must record a greeting for each mailbox. In your greeting state which mai
has been reached and tell callers how to leave a message. For example, you
record your General Delivery Mailbox Greeting to say:

“Hello. You have reached Warrington’s General Delivery Mailbox. At the sound
the tone, please leave the name of the person you are calling and your mess
Your message will be returned as soon as possible.”

Before you record the Special Mailbox Greetings, prepare a greeting for each
mailbox. Include the Special Mailbox name in your greeting.

To record a Special Mailbox Greeting:

1. Press ƒ·°⁄.

2. Enter your password, then press OK.

If the set you are using has a mailbox, the  
Pswd: prompt appears. Press  OTHR to display 
the  Log: prompt.

3. Press ADMIN.

4. Press GREET.

5. Press REC.

6. Press PRIME to record your Primary Greeting
or
press ALT to record your Alternate Greeting.

For information on recording Personalized 
Greetings, refer to the Enterprise Edge 2.0 
Voice Messaging Reference Guide.

7. Press YES.

8. At the tone, record your greeting and press OK.

Log:
QUIT        RETRY         OK

0 new     0 saved
PLAY        REC       ADMIN

Mailbox admin
GREET       PSWD      QUIT

Greeting options
REC       CHOOSE      CFWD

Greeting:
PRIME        ALT        PERS

Record new?
YES            NO         QUIT

Record greeting:
RETRY                         OK
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After the Primary and Alternate Greetings are recorded, you must select a gre
to play. If you do not select a greeting to play, the Primary Greeting plays 
automatically.

Selecting a Mailbox Greeting
For a Primary or Alternate Greeting to play, you must select a greeting. If you
not choose a greeting, the Primary Greeting plays automatically. If you choos
Alternate Greeting, remember to change back to the Primary Greeting at the 
appropriate time.

If you select a greeting that is not yet recorded, you are transferred back to th
Greeting option display to record the greeting.

To choose a Primary or Alternate Greeting:

9. Press OK to accept the greeting.

If you are not satisfied with this greeting, press
RETRY and rerecord the greeting. Pressing • 
returns the display to the previous prompt. 

10. For each Special Mailbox Greeting, follow 
steps 1 through 9
or
press ® to end this programming session.

1. Press ƒ·°⁄.

2. Enter the System Administrator Mailbox 
number and password and then press OK.

If the set you are using has a mailbox, the  
Pswd: prompt appears. Press  OTHR to display 
the  Log: prompt.

3. Press ADMIN.

4. Press GREET.

5. Press CHOOSE.

6. Select the greeting you want to play.

Press ® to end this programming session.

Accept greeting?
RETRY        PLAY        OK

Log:
QUIT        RETRY         OK

0 new     0 saved
PLAY        REC        ADMIN

Mailbox admin
GREET       PSWD      QUIT

Greeting options
REC      CHOOSE       CFWD

Use greeting:
PRIME       ALT         QUIT
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Listening and responding to messages left in Special Mailboxes
Messages left in the Special Mailboxes must be listened to daily. To save me
storage space, delete a message from the mailbox after you listen to it.

Controling volume

Press • to adjust the volume of a message. The volume increases each time
press•. After four consecutive presses, the volume returns to the lowest lev
This option is not shown on the display.

Volume control does not apply to system prompts. The system prompts play a
preset volume.

Delivery Options

When leaving a message in a mailbox, Enterprise Edge Voice Messaging pro
you with Delivery Options: Certified, Urgent, Private, and Normal.

• Certified (CERT)
This notifies you that your message has been received and read. The Cer
Delivery Option can be applied only from an internal telephone if the caller
a mailbox recognized by the system.

• Urgent (URGENT)
This marks the message urgent and is preceded by the voice announcem
“This message is urgent”. Messages marked Urgent play before other messa
left in the mailbox.

• Private (PRIV)
This prevents a message from being forwarded to another mailbox.

• Timed (TIME)
This allows a mailbox owner to delay delivery of a message until after a 
specified date and time. The Timed Message option is not available to ou
callers.

• Normal
If a delivery option is not chosen, the message is sent normally.

If only PRIV or TIME apply, that option replaces OTHR on the first display.
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To open and listen to messages left in a Special Mailbox:

After a message plays you can:

• Press fl or £ or NEXT to listen to the next message.

• Press · or REPLY to reply to the message sender.

• Press ° or ERASE to erase the message.

• Press ⁄ to replay the message.

• Press › to listen to the previous message.

• Press fi to forward a copy of the message.

• Press ‡ to listen to the message date and time.

• Press ‡‡ to save the message.

After you listen to the messages, press ® to end the session.

1. Press ƒ·°⁄.

2. Press OTHR.

If the extension you are using has a mailbox, 
the Pswd: prompt appears. Press OTHR to 
display the Log: prompt.

3. Enter the System Administrator Mailbox 
number and password, then press OK.

4. Press PLAY. 
The first message in the mailbox is played.

To listen to the date and time the message wa
sent, press ‡ while the message is playing or 
after it has played.

5.  If the message is left by someone in your 
company who does not have an extension or 
mailbox, the option display line shows: COPY  
ERASE NEXT.

Pswd:
OTHR         RETRY       OK

Log:
QUIT         RETRY        OK

1 new     0 saved
PLAY        REC       ADMIN

End of message
COPY      ERASE      NEXT
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Copying a message to another Mailbox
You can use the COPY feature to copy a message left in the Special Mailboxes (o
Personal Mailbox) to any mailbox owner with an initialized mailbox. You cann
copy a message if the original message is:

• designated as Private by the sender

• a Broadcast Message, which deletes automatically after it plays

When the display shows the REPLY feature, press fi to continue to the next display.
If a message is left by an internal caller who has a mailbox initialized with 
Enterprise Edge Voice Messaging, the display shows the REPLY feature. The 
display also shows REPLY if a message is left by an external caller and your 
company subscribes to Call services. Otherwise, the display line options sho
COPY feature.

To send a copy of a message to a mailbox owner, you must open the mailbo
listen to the message.

1. Press ƒ·°⁄.

2. Enter the System Administrator Mailbox 
number and password, then press OK.

3. Press PLAY.

4. Press COPY.

If the display does not show the COPY option, 
press fi to continue to the next display.

5. Press YES.

Press NO to copy the message without an 
introduction. The display changes to show:  
Mbox:.

6. At the tone, record the message introduction. 
The introduction to a message must be more 
than three seconds long.
Press OK to end the recording.

7. To accept the recording, press SEND.

To listen to your introduction before you send 
the message, press PLAY.

To record the introduction again, press RETRY.

Pswd:
OTHR         RETRY       OK

1 new     0 saved
PLAY        REC       ADMIN

End of message
COPY      ERASE      NEXT

Record intro?
YES                             NO

Record intro:
RETRY                        OK

Accept intro?
RETRY     PLAY       SEND
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Replying to a message
When a message is left in a Special Mailbox or any Personal Mailbox by an int
mailbox owner, you can use the Reply feature to respond to the message. Yo
reply by calling the message sender or by sending them a message.

If your company subscribes to CLID, the Reply feature can also be used for ext
calls, provided a Dialing Translation Table is created.

8. Enter the mailbox number that is to receive th
message
or
press DIR to select the mailbox number using 
the Company Directory.

9. To deliver your introduction and message 
normally, press SEND 
or
to select sending options, press OPTS.

10. To mark a message Certified, press CERT, then 
press SEND. To mark a message Urgent, press 
URGENT, then press SEND.

To mark a message Private, press OTHR, then 
press PRIV, then SEND.

To send a Timed Message, press OTHR, then  
TIME, then follow the time and date prompts.

If only one of PRIV or TIME apply, that button 
replaces the OTHR button at the Delivery 
Options prompt.

To cancel Delivery Options, or return to the 
options menu, press •.

11. This display appears briefly to acknowledge 
the message has been sent.

12. Press QUIT to end this session
or
press YES to forward a copy of this message to
another mailbox.

Press ® to end this programming session.

Mbox:
DIR                         QUIT

Name:
OPTS          CC          SEND

Delivery options
CERT     URGENT     OTHR

Delivery options
PRIV                        TIME

Msg delivered

Another copy?
YES                          QUIT
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Replying to an internal message sender

To reply to an internal message by calling the sender, you must first open the
mailbox and listen to the message:

Calling an external message sender

Before you can reply to an external caller, your mailbox must have an Outdial r
assigned and your system must be equipped with Call Display. To reply to an
external message, you must first open the mailbox and listen to the message

1. Press ƒ·°⁄.

2. Enter your password, then press OK.

3. Press PLAY.

4. Press REPLY.

5. Press CALL. You are transferred to the messag
sender’s extension.
Press MSG to reply with a recorded message.

1. Press ƒ·°⁄.

2. Enter your password, then press OK.

3. Press PLAY.

4. Press REPLY.

Pswd:
OTHR         RETRY       OK

1 new    0 saved
PLAY        REC       ADMIN

End of message
REPLY    ERASE      NEXT

Reply to msg
MSG         CALL        QUIT

Pswd:
OTHR         RETRY       OK

1 new     0 saved
PLAY       REC        ADMIN

End of message
REPLY     ERASE     NEXT
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5. Press DIAL.
When this display appears, you have the optio
of adding or removing digits from the number 
to be outdialed. This display does not appear 
a Dialing Translation Table is established and
enabled, or if the Caller ID number does not 
require translation. In these cases you see 
Please hold while the number dials directly.

Note: Press TRIM to remove digits from the beginning 
of the phone number. This automatically 
removes the area code from an incoming long
distance call.
To return the call, add more digits to the 
beginning of the phone number by entering th
required digits. For example, if you want to 
add 403 before the number, enter 403 and the
number becomes 403-123-4567.

1234567    403
DIAL       TRIM         QUIT
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Creating Mailboxes

Overview
This chapter contains information on how to create the different types of mailb

Tools and materials
Before you begin to create mailboxes, complete the Mailboxes section of the
Enterprise Edge 2.0 Voice Messaging Programming Record.

User Mailboxes
Mailboxes are installed by enabling a Mailbox Software Keycode on the Enterp
Edge server. The Mailbox Software Keycode limits the number of Subscriber
mailboxes that you can add to Enterprise Edge Voice Messaging. For examp
you enable a 16 Mailbox Security Keycode, you can have a maximum of 16 
Subscriber mailboxes on the Enterprise Edge server. If you need more than 1
Subscriber mailboxes, you must purchase another Mailbox Security Keycode.
can have a maximum of 1,000 mailboxes on the Enterprise Edge server.

You can add new mailboxes to Enterprise Edge Voice Messaging whenever 
are required. You cannot add more mailboxes than the number of mailboxes 
installed on the Enterprise Edge server. Before you add a new mailbox, ensur
you have all the necessary mailbox information. Complete Mailboxes in the 
Enterprise Edge Voice Messaging Programming Record, outlining the:

• mailbox number

• extension

• Class of Service

• mailbox owner’s name (last name and first name or initial)

• mailbox type

• Company Directory, Message Waiting, and Outdial Overrides

• Alternate extensions (for User Mailboxes only)

• Express Messaging Line number

When adding Information Mailboxes, assign a Class of Service that has the 
maximum message length. To accommodate an average Information Mailbox
message, assign a Class of Service of either 7 or 8. These Class of Service v
have a message length of 10 minutes.

8
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Adding a User Mailbox
To add a single mailbox:

1. Click the Mailbox  menu and then click Add.
The Add Mailbox dialog box is displayed.

2. In the Mailbox  box, type the mailbox number.

3. At the Mailbox Type option, select Subscriber.

4. Click the OK  button.
The Mailbox Properties dialog box appears, with the General tab open.

5. In the Extension box, type the extension.

6. In the Last Name and the First Name boxes, type the mailbox owner’s last 
and first names.

7. From the COS list, select a Class of Service.

8. Select the Directory  check box if you want the mailbox owner’s name to pla
in the Company Directory.

9. Click the Options tab.

10. In the Alternate Extension 1 box, type the Alternate extension (if required).
If you do not require an alternate extension leave this box empty.

11. In the Alternate Extension 2 box, type the second Alternate extension (if 
required). If you do not require a second alternate extension leave this bo
empty.

12. If you want to assign an Express Messaging Line to the mailbox, in the 
Express Messaging Line box type the line number.

13. Click the Msg Waiting check box if you want message notification to appe
on the mailbox owner’s telephone display.

14. Select the Call Screening check box to assign screened transfers to the 
mailbox owner. Clear the Call Screening check box to assign blind transfe
the mailbox owner.

15. Click the Outdial  tab.

16. Click Line and type the specific outgoing line you want to assign to the 
mailbox for outdialing or click Pool and type the Line Pool number you wan
to assign to the mailbox for outdialing or click Route to assign a route code 
for outdialing. Click None if you do not want to assign outdialing capabilitie
to the mailbox.

17. Click the OK  button.
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Adding multiple mailboxes
You can save time by creating multiple mailboxes when you set up Enterprise 
Voice Messaging for the first time or add a large number of telephone users to
system. Adding many mailboxes creates Subscriber mailboxes for the range 
extensions that you define. You must use extensions that are not already ass
to mailboxes. Before you create multiple mailboxes, use telephony administra
to define the new extensions and assign user names to the extensions.

To make the most effective use of adding multiple mailboxes, identify the use
who need a non-standard Subscriber mailbox. Create these mailboxes individ
After you finish, add multiple mailboxes for the remaining Subscriber mailbox

The mailboxes have the following characteristics:

• the Mailbox number is the same as the extension

• Class of Service the same for all mailboxes

• Call screening default is blind (off)

• the mailbox name is taken from the Enterprise Edge extension programmin
it is complete

• Message Waiting notification is enabled

• the Outdial route is the same for all mailboxes

The mailboxes created are uninitialized and ready for initialization by the individ
mailbox owners.

A Subscriber mailbox is not created if:

• a mailbox of the same number already exists

• the extension is used by another mailbox

• the extension is identified as a Enterprise Edge Voice Messaging voice 
extension

To add multiple mailboxes:

1. Click the Mailbox  menu and then click Add many.
The Add Many Mailboxes dialog box appears.

2. In the From Extension box, type the extension you want to start creating 
mailboxes from.

3. In the To Extension box, type the extension you want to stop creating 
mailboxes at.

4. In the COS list box, select a Class of Service.
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5. At the Outdial  option, click Line and type the specific outgoing line you wan
to assign for outdialing 
or
click Pool and type the Line Pool number you want to assign for outdialing
or
click Route to assign a route code for outdialing
or
click None if you do not want to assign outdialing capabilities.

6. At the Options option, select the Directory  check box if you want the 
mailbox owner’s name to play in the Company Directory.

7. Select the Msg Waiting check box if you want Message Notification to 
appear on the mailbox owner’s telephone display.

8. Select the Call Screening check box to assign screened transfers to the 
mailbox owner. Clear the Call Screening check box to assign blind transfe
the mailbox owner.

9. Click the OK  button.

Guest Mailboxes
Assign Guest Mailboxes to users who do not have an operating Enterprise E
extension, but require a mailbox. These mailboxes receive and store messag
as the User Mailboxes do.

When you create Guest Mailboxes, use mailbox numbers that begin with the 
digit. This identifies the mailbox type. Use a digit that is different than the Use
Mailbox numbers. For example, if the User Mailbox numbers start with two, th
Guest Mailboxes can start with four.

When to use Guest Mailboxes
Guest Mailboxes can provide a temporary employee or a with Enterprise Edg
Voice Messaging services, or give clients access to internal messaging and c
routing. Guest Mailboxes with Outbound Transfer enabled are ideal for 
telecommuters. Guest Mailboxes can also be used to allow customers to mak
telephone orders.

Depending on your business, you can use Guest Mailboxes for:

• personal catalog shopping orders

• listing classes or seminars and providing callers with the ability to register
telephone

• providing frequent customers access to Enterprise Edge Voice Messaging
services

The following example suggests how you can set up a Guest Mailbox for an 
announcement and order-taking capability. When you provide services that al
customer to call into a mailbox, you record the mailbox number in the Compa
Greeting. This allows a caller to transfer directly to the mailbox.
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Example 1 - Announcing courses and seminars (telephone registration)

To use a Guest Mailbox to provide telephone registration, you must first deter
a mailbox number. The Guest mailbox number you assign does not have a wo
Enterprise Edge extension. Next, you must determine what the Mailbox Gree
says. For example:

“This month we are pleased to provide the following courses: Jazz Dancing M
Easy, Intermediate Jazz Dancing, Warming Up for that Big Performance, and
Beginners’ Ballet. If you are interested in any of these courses, leave your nam
phone number after the tone. One of our instructors will contact you with mor
information.”

You can even include the time and date the classes are offered. This exampl
applicable to Guest Mailboxes that are used for taking orders.

After you determine what the announcement says, record a Company Greeti
inform callers this mailbox is available. For example:

“Good Morning. This is On Your Toes Dance School. To reach the dance stu
press ›fl. To register for our fall classes, press ¤°. To reach our 
receptionist, press ‚.”

Note: The number 46 in this example is an operating Enterprise Edge extens
and the number 28 is the Guest Mailbox.

The leading digit of Guest Mailbox numbers must be different from the leadin
digit of the extensions. If you must use the same leading digit, ensure the Gu
Mailbox numbers are “out-of-range” extensions. To test if an extension is out
range, dial it from another extension. If the number is out-of-range, the displa
shows Invalid number. If the number is not out-of-range, the display shows Not 
in service.

You must assign a Class of Service. When you assign a Class of Service for a
Mailbox that is used as an order mailbox, choose a Class of Service that has
maximum mailbox greeting recording and message time available. Refer to Class 
of Service on page 56.
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Adding Guest Mailboxes
To add a Guest Mailbox:

1. Click the Mailbox  menu and then click Add.
The Add Mailbox dialog box appears.

2. In the Mailbox  box, type the mailbox number.

3. At the Mailbox Type option, select Subscriber.

4. Click the OK  button.
The Mailbox Properties dialog box appears with the General tab open.

5. Leave the Extension box blank.

6. In the Last Name box, type the mailbox owner’s last name.
The last name can be a maximum of 15 characters.

7. In the First Name box, type the mailbox owner’s first name.
The first name can be a maximum of 15 characters.

8. From the COS list, select a Class of Service.

9. Select the Directory  check box if you want the mailbox owner’s name to pla
in the Company Directory.

10. Click the Options tab.

11. Leave the Alternate Extension 1 box blank.

12. Leave the Alternate Extension 2 box blank.

13. If you want to assign an Express Messaging Line to the Guest Mailbox, in
Express Messaging Line box type the line number.

14. Ensure the Msg Waiting check box is clear.

15. Ensure the Call Screening check box is clear. Guest mailboxes must have 
blind transfers.

16. Click the Outdial  tab.

17. Select None. To avoid toll charges, you do not want to assign outdialing 
capabilities to a Guest mailbox.

18. Click the OK  button.
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Information Mailboxes
Information Mailboxes play information messages to callers. Information 
Mailboxes do not take messages and do not have operating extensions.

Information Mailboxes are initialized by you, and are maintained either by you
an Enterprise Edge Voice Messaging mailbox owner. You can add Informatio
Mailboxes whenever one is needed.

When to use Information Mailboxes
Information Mailboxes can be used to:

• announce sales

• provide product lists

• announce special events

A caller disconnects automatically after listening to an Information Mailbox. 
Information Mailbox Greetings can be recorded by you or by the user who ha
Information Mailbox. For more information about recording Information 
Greetings, refer to the Enterprise Edge 2.0 Voice Messaging Reference Guide.

You must make sure the Information Mailboxes are accessible to outside call
You can make callers aware of your company’s Information Mailboxes if you:

• Advertise the Automated Attendant main number and record a Company 
Greeting that informs the caller of the Information Mailbox services. You c
also provide a list of your company’s Information Mailboxes in brochures a
telephone directory advertising.

• Record Information Mailboxes in the Company Greeting if your company 
a small number of Information Mailboxes, such as three or four. Use Cust
Call Routing (CCR) if you have a large number of mailboxes.

• Assign the Operator as the Transfer node for all Information Mailbox inquir
Record a statement in the Company Greeting that tells a caller to press ze
reach company information. For example:

“Good Afternoon. This is On Your Toes Dance Studio. To reach our studio
press ›fl. To listen to one of our special announcements, press ‚ to reach 
the Operator.”

• When a caller presses zero, the Operator provides a list of the Information
Mailboxes and transfers the caller accordingly.
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Adding Information Mailboxes
Before you can add an Information Mailbox, you must determine a Class of Ser
The Class of Service must have a message length that is long enough for an
Information Greeting. Refer to Class of Service on page 56.

When you add Information Mailboxes, use mailbox numbers that begin with t
same digit. This helps you identify the mailbox type.

To add an Information Mailbox:

1. Click the Mailbox  menu and then click Add.
The Add Mailbox dialog box appears.

2. In the Mailbox  box, type the mailbox number.

3. At the Mailbox Type option, select Information .

4. Click the OK  button.
The Mailbox Properties dialog box appears with the General tab open.

5. In the Last Name box, type the mailbox owner’s last name.
The combined characters for the last name and the first name can be a 
maximum of 15 characters.

6. In the First Name box, type the mailbox owner’s first name.
The combined characters for the last name and the first name can be a 
maximum of 15 characters.

7. From the COS list, select a Class of Service.

8. Select the Directory  check box if you want the mailbox owner’s name to pla
in the Company Directory.

9. Click the OK  button.
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Changing and Deleting Mailboxes

Overview
This chapter discusses how to change mailbox options and how to delete a ma

Changing mailbox options
After a mailbox is initialized with Enterprise Edge Voice Messaging, you can 
change several options and overrides. You can:

• reset a mailbox password

• change a mailbox extension

• change a mailbox Class of Service

• change a mailbox owner’s name

• change the Company Directory Override

• change Message Waiting Notification status

• change the Mailbox Outdial route

• change the Alternate extensions

• change the Call Screening feature status

Resetting a mailbox password

Resetting a mailbox password changes it to the default password 0000. Rese
password only if the mailbox owner forgets the password or if the mailbox ow
is “locked-out”. After a mailbox password is reset, you must tell the mailbox ow
to change the default password. A mailbox cannot be opened until the defaul
password is changed.

To reset a mailbox password:

1. Click the Mailbox  menu and then click Change/Delete.
The Mailbox List dialog box appears.

2. Click the name of the mailbox you want to modify.

3. Click the Change button.
The Mailbox Properties dialog box appears.

4. Select the Reset Password to default check box.

5. Click the OK  button.

6. Click the Close button.

9
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Changing mailbox options

To change any of the mailbox options:

1. Click the Mailbox  menu and then click Change/Delete.
The Mailbox List dialog box appears.

2. Click the name of the mailbox you want to modify.

3. Click the Change button.
The Mailbox Properties dialog box appears with the General tab open.

4. Modify the extension number, first or last name of the mailbox owner, Cla
of Service or Company Directory availability.

5. Click the Options tab to modify the Alternate extension numbers, Message
Waiting notification or Call Screening settings.

6. Click the Outdial  tab to modify the Outdialing route information.

7. After you modifying the mailbox, click the OK  button.

8. Click the Close button.

Deleting a mailbox
Before you delete a mailbox, ensure the mailbox owner has listened to all the
messages. When you delete a mailbox, all messages stored in that mailbox a
deleted and the mailbox is deleted automatically from the Company Directory
all Group Lists.

If you are deleting a mailbox associated with a CCR Tree, make sure you rem
the mailbox from the CCR Tree first. If you do not delete the mailbox, the mess
Mbox in CCR appears on your display.

To delete a mailbox:

1. Click the Mailbox  menu and then click Change/Delete.
The Mailbox List dialog box appears.

2. Click the name of the mailbox you want to delete.

3. Click the Delete button.
A message appears that asks you to confirm the deletion.

4. Click the OK  button.

5. Click the Close button.
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Mailbox Administration Tasks

Overview
This chapter describes the steps for administering Enterprise Edge Voice 
Messaging mailboxes, including:

• Special Mailboxes (System Administrator Mailbox and General Delivery 
Mailbox)

• Personal Mailboxes (User and Guest)

• Information Mailboxes

Administering Special Mailboxes
Special Mailbox administration involves listening to messages, attending to e
message, and then deleting the message. Attend every day to messages left
Special Mailboxes.

There are two Special Mailboxes: System Administrator and General Delivery.
can use the following features for both types.

When a message is left in the System Administrator Mailbox, you can respon
the message in your role as System Administrator.

When a message is left in the General Delivery Mailbox for a mailbox owner, 
can send the message from the General Delivery Mailbox to the owner’s mai
if they have one.

Administering Personal Mailboxes
A Personal Mailbox is administered mainly by the mailbox owner and requires 
little administration from you.

The Personal Mailbox administration tasks that you perform include changing
mailbox options such as:

• resetting a password to 0000 if a mailbox owner forgets their password

• mailbox extension

• Class of Service

• mailbox owner’s name

• mailbox overrides, including Alternate extensions (User Mailboxes only), Fax 
line number (User mailboxes only on systems with FAX enabled) and statu
the Call Screening feature.

System Administrator tasks also include adding or deleting Personal Mailbox
For information about adding mailboxes, refer to User Mailboxes on page 77, and 
Adding multiple mailboxes on page 79.

For more information about Personal Mailbox Options and administration see
Enterprise Edge 2.0 Voice Messaging Reference Guide.

10
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About mailbox passwords
Each mailbox certified with Enterprise Edge Voice Messaging is protected by
password established by the mailbox owner. When you add a mailbox to Enter
Edge Voice Messaging, the password 0000 is assigned automatically. This is
default password.

To use a mailbox, a mailbox owner must change the default password. The n
password must be four to eight digits in length and cannot start with zero.

If a mailbox owner cannot remember their password, you can reset the passw
the default password 0000. Refer to Changing mailbox options on page 85.

Incorrect password lock-out
In its Class of Service each mailbox is assigned a maximum number of incorr
password attempts. Enterprise Edge Voice Messaging records the number o
incorrect attempts since the last time the mailbox was accessed successfully.
number is of attempts is exceeded, the mailbox owner is “locked-out”. The mai
cannot be opened again until the password is reset. Refer to Changing mailbox 
options on page 85.

Password expiry
In its Class of Service each mailbox is assigned the maximum number of day
password remains active. When the maximum number of days is exceeded t
mailbox password expires. The mailbox owner can open the mailbox but can
access messages or perform other mailbox functions until the password is cha
Unless the telephone has a two line display, the following voice announceme
played when the mailbox is opened after the password expires:

“Your current password has expired. You must change your password.
Please enter your new password, then press £.”

After the new password is entered the mailbox returns to normal operation.

Caution: Change your System Administrator password frequently to minimize 
the risk of unauthorized activity.

Caution: Set the Class of Service password expiry to a low value so that 
mailbox owners must change their password often. Mailboxes with a Class of 
Service value that has a high or indefinite password expiry interval setting have 
an increased likelihood of unauthorized use of the Enterprise Edge Voice 
Messaging system.
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Enabling external initialization
You can assign Mailbox initialization to be performed only from an internal 
Enterprise Edge telephone. This added security feature makes it difficult to ta
with or gain access to the mailboxes fraudulently.

If a user attempts to access an uninitialized mailbox from an external number,
are denied access. After the mailbox is initialized, the user can access the m
from any touch tone phone. The default setting for the External Initialization fea
is off.

To enable External Initialization:

1. On the Options menu click System Parameters.
The System Parameters dialog box appears.

2. At the External Initialization  option, select Enable.

3. Click the OK  button.

Configuring the Company Directory
You can determine whether callers can search the Company Directory by firs
name, last name or both first and last name. You can also disable the Compa
Directory if necessary. For more information about the Company Directory, re
to Company Directory on page 59.

To configure the Company Directory:

1. On the Options menu click System Parameters.
The Systems Parameters dialog box appears.

2. At the Directory Search by option, select First Name, Last Name or Both.

3. Click the OK  button.
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Setting up Outcalling Channels

Designating the number of channels for Off-premise Message Notification and 
Outbound Transfer

For Off-premise Message Notification, fax printing and AMIS networking to wo
voice channels must be available to Enterprise Edge Voice Messaging. You m
assign channels to Enterprise Edge Voice Messaging to place outgoing calls

Set Outcalling channels to no more than half of the total channels available o
Enterprise Edge Voice Messaging.

Do not assign all station channels on your system as voice channels for Outca
Ensure you reserve enough channels to accommodate incoming calls.

Note: Enable Outbound Transfer only for users who require this feature. 
Outbound Transfer increases the likelihood of unauthorized use of the
Enterprise Edge Voice Messaging system, especially when the line, po
route code assigned allows long distance dialing.

To designate the number of channels for Outcalling:

1. On the Options menu click System Parameters.
The System Parameters dialog box appears.

2. In the Number of Outcalling Channels box, type the number of outcalling 
channels.

3. Click the OK  button.

Enabling and disabling the General Delivery Mailbox
The default status for the General Delivery Mailbox is enabled. The General 
Delivery Mailbox can be disabled or enabled as required by your company.

To assign the General Delivery Mailbox:

1. On the Options menu click System Parameters.
The System Parameters dialog box appears.

2. At the General Delivery Mailbox option, select Yes for enabled or No for 
disabled.

3. Click the OK  button.

Callers who reach the General Delivery Mailbox can leave a message if the Ge
Delivery Mailbox is enabled. If it is disabled, callers hear the Automated Attend
Voice Prompt. At any time, callers can press ‚ to reach the Operator.
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Setting up the Operator’s Mailbox
If the Operator is not available, any calls that request the Operator transfer to
General Delivery Mailbox. Assign the General Delivery Mailbox number to yo
company’s designated Operator. The extension can be any operating extens
your Enterprise Edge Voice Messaging System that is not already assigned t
mailbox.

To change the mailbox number:

1. On the Options menu click Operator Settings.
The Operator Settings dialog box appears.

2. In the Attendant box, type the Operator’s mailbox extension.

3. Click the OK  button.

Broadcast and Group messages
Apart from the day-to-day messages you send, there can be times when you n
send a Broadcast Message to all mailbox owners, or a Group Message to a 
designated group of mailboxes.

This section describes how to:

• send a Broadcast Message

• create or delete a Group List

• change the members of a Group List

• view the members of a Group List

• send a Group Message

Sending Broadcast Messages
A Broadcast Message sends the same message is delivered to each mailbox
eliminates recording and sending the same message several times. Broadca
Messages can be sent to announce meetings, special company events, and 
reminders.

Only you, as System Administrator, can send Broadcast Messages. You sen
Broadcast Message by entering ƒ·°⁄, logging on and pressing  ·.

Broadcast Messages play on all mailboxes initialized with Enterprise Edge Vo
Messaging. A mailbox owner does not have to select a Broadcast Message to
The message plays automatically when mailbox owners open their mailboxes
erases automatically after it plays.

A Broadcast Message plays only once for each mailbox owner.

Broadcast Messages are not sent to Information or Special Mailboxes.
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Sending a Broadcast Message

To send a Broadcast Message, you must first open your System Administrato
Mailbox:

Your message is delivered to all mailboxes initialized with Enterprise Edge V
Messaging.

Sending Group Messages
Group Messages can be sent by any user, but the Group List to which the me
are sent must be defined or changed by the System Administrator.

Before you can send a Group Message, you must first define a Group List. A G
List contains all the mailbox numbers that receive a group message. For exa
you can group all mailboxes from the accounting department into a Group List
all the mailboxes from the shipping department into another Group List.

A Group List can include only mailbox numbers. A Group List cannot include 
number of another Group List.

The Group List feature is enabled during installation.

1. Press ƒ·°⁄.

2. Press OTHR.

Note: If the set you are using does not have a
mailbox, the  Log: prompt appears.

3. Enter the System Administrator Mailbox 
number and password, then press OK.

4. Press ·.

5. At the tone, record your message and press OK.

6. To listen to your message before sending it, 
pressPLAY.

Press  OK to accept your recording. The display
changes to show Msg delivered.

To record your message again, press RETRY.

Press ® to end this programming session.

Pswd:
OTHR       RETRY       OK

Log:
OTHR      RETRY        OK

0 new     0 saved
PLAY      REC       ADMIN

Record message:
RETRY     PAUSE       OK

Accept rec?
RETRY      PLAY        OK
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Preparing a Group List
Preparing a Group List is similar to setting up a new mailbox. You assign a num
and a name to a Group List. The leading digit for Group Lists is 9. You can ch
the Group List leading digit at any time, if necessary. The next two digits are 
assigned automatically by Enterprise Edge Voice Messaging when you add t
Group List. The Group List numbers are assigned in sequential order. You m
assign the Group List name. For information about Fax Group Lists, refer to 
Enterprise Edge 2.0 Voice Messaging FAX Set Up and Operation Guide.

Enterprise Edge Voice Messaging allows 99 Group Lists. Each Group List ca
contain a maximum of 1,000 mailboxes. Before you begin to add Group Lists,
must prepare a group mailbox member list. Ensure that this list contains:

• leading digit – (see Group List Numbers on page 93)

• Group List name – maximum 16 characters long

• mailbox numbers – to be included in the group

A mailbox must be initialized before it can be added to a Group List.

After you establish a Group List, you can change the mailboxes included in the
record a new list name, view the Group List, or delete the Group List.

Group List Numbers

The number 9 is assigned as the default Group List leading digit. For example
default Group List numbers are 901 to 999. If the leading digit is 5, the Group
numbers are 501 to 599. The Group List numbers are always three digits lon

You can change the Group List leading digit if necessary. For more informatio
changing the Group List leading digit, refer to Changing the Group List leading 
digit on page 95.

The Group List number acts like a mailbox number when you leave a messag
the mailboxes in the Group List. The table Sample Group List shows two sample 
Group Lists.

Sample Group List

Group List no. Name Mailbox no.

901 Sales 224

223

233

902 Shipping 227

221
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Adding a Group List
To add a Group List:

1. Click the Group Lists menu.
The Group Lists dialog box appears.

2. Click the Add button.
The Group List dialog box appears.

3. In the Group List Name box, type the new Group List name.

4. Follow the steps in Recording a greeting or prompt from your telephone 
handset on page 27 to record a spoken Group List name from your telepho
handset
or
follow the steps in Recording a greeting or prompt from your PC on page 28 
to record a spoken Group List name from your PC
or
follow the steps in Locating a previously recorded greeting or prompt on page 
28 to select a previously recorded Group List name.

5. From the Available list, click a mailbox that you want to include in the Grou
List.

6. Click the Add button to copy the mailbox into the Current Members list.
Repeat steps 5 and 6 for each mailbox that you want to include in the Gro
List.

7. After you add all the members to the Group List, click the OK  button and then 
click the Close button.

Changing a Group List
A Group List Name and mailbox numbers can be added to or deleted from a G
List at any time. Mailboxes must be initialized before they can be added to a G
List. You cannot change a Group List number. To change a Group List number
must delete the Group List and add new member mailbox numbers as a new G
List. For more information, refer to Adding a Group List on page 94.

To change a Group List:

1. Click the Group Lists menu.
The Group Lists dialog box appears.

2. If you want to change the Group List name, click the name of the group, a
then click the Change button.

3. Enter the new Group List name.
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4. Follow the steps in Recording a greeting or prompt from your telephone 
handset on page 27 to record a spoken Group List name from your telepho
handset
or
follow the steps in Recording a greeting or prompt from your PC on page 28 
to record a spoken Group List name from your PC
or
follow the steps in Locating a previously recorded greeting or prompt on page 
28 to select a previously recorded Group List name.

5. Select a mailbox from the Current Members Available list that you want to 
remove from the Group List.

6. Click the Remove button to remove it from the Current Members list.

7. Select a mailbox from the Available list that you want to include in the Group
List.

8. Click the Add button to copy the mailbox into the Current Members list.

9. After you make the necessary changes to the Group List, click the OK  button.

Changing the Group List leading digit
You can find it necessary to change the Group List leading digit. For example
is assigned as the Group List leading digit, 901 to 999 is your range of Group L
If you change the leading digit to 5, the Group List numbers change to 501 to
The Group List numbers are always three digits long.

Note: You cannot change the Group List leading digit to a number that confli
with mailbox numbers. For example, if your company has mailboxes 
ranging from 500 to 720, you cannot choose 5, 6 or 7 as the Group Lis
leading digit.

To change the Group List leading digit:

1. On the Options menu click System Parameters.
The System Parameters dialog box appears.

2. In the Group List Leading Digit  box, type the new leading digit.

3. Click the OK  button.
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Deleting a Group List
You can delete a Group List at any time. If you delete a Group List, the Group
number is re-assigned automatically by Enterprise Edge Voice Messaging the
time you add a Group List. Deleting a Group List does not delete any mailbox
from the Enterprise Edge Voice Messaging system.

To delete a Group List:

1. Click the Group Lists menu.
The Group Lists dialog box appears.

2. Click the Group List you want to delete.

3. Click the Delete button.

4. Click the OK  button to confirm the deletion.

5. Click the Close button.

Sending a Group Message
You can sent a Group Message whenever you want to notify a specific group
mailboxes of a pending event or company notice that pertains to the group. A G
List message must be selected to play, just as a regular message is selected
a mailbox owner can listen to it. Unlike a Broadcast Message, a Group List mes
does not play automatically. When a mailbox owner sends a message to the G
List, the mailbox owner’s own mailbox does not receive the message.

To send a Group Message from your Enterprise Edge telephone:

1. Press ƒ·°‚.

2. Enter the Mailbox number.

3. Enter the Group List number and press OK.

4. At the sound of the tone, record your messag
and press OK to end your recording.

5. Press RETRY to record your message again
or
press PLAY to replay your message
or
press SEND to accept and send your message.

Press ® to end this programming session.

Mbox:
DIR                        QUIT

Grp List:
RETRY                       OK

Record message:
RETRY      PAUSE       OK

Message options:
RETRY      PLAY     SEND

Leave message:
NEW                       MBOX
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Caller ID (CLID)
If your company subscribes to Caller ID, also known as Calling Line Identificat
or CLID, the caller’s number or name and number appears on the telephone’
display if the telephone has a one or two-line display. 

Caller ID is one of the options needed to use the Reply feature for external ca

You must assign the number of rings to two or more on lines equipped with C
ID for pre-recorded Personalized Greetings to play. Caller ID information does
appear until just prior to the second ring.
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Mailbox feature codes

Overview
Callers use feature codes to perform Enterprise Edge Voice Messaging funct
There are nine feature codes that work with Enterprise Edge Voice Messaging
table Description of feature codes explains the purpose of each Enterprise Edge
Voice Messaging feature code.

Feature codes are assigned during installation. You can program the feature 
onto memory buttons. For information, refer to Programming a memory button on 
page 100.

Description of feature codes

Feature code name Feature code buttons Description

Leave Message ƒ·°‚ Leaves a message in a mailbox. No password is 
required.

Open Mailbox ƒ·°⁄ Opens your Personal mailbox. Your personal 
password is required.

Operator Status ƒ·°¤ Used by the System Administrator, receptionist, or 
Operator to set the Operator Status. When an opera
is not available, set the Operator Status to No. This 
alerts the Automated Attendant that the Receptionist
or designated Operator is not available. Operator 
Status also establishes whether a business is open o
closed, and designates the Operator’s extension. 
Operator Status is protected by a password.

Call Forward to 
Enterprise Edge Voice 
Messaging

ƒ·°› Forwards incoming calls to Enterprise Edge Voice 
Messaging.

Enterprise Edge Voice 
Messaging extension

ƒ·°fi Determines the Enterprise Edge Voice Messaging 
extension. This number is used to access Enterprise
Edge Voice Messaging from a one line display 
telephone attached to an Enterprise Edge ATA 2 or a
Analog Station Module.

Transfer ƒ·°fl Transfers calls to a mailbox.

Interrupt ƒ·°‡ Interrupts Enterprise Edge Voice Messaging when a
caller is listening to your personal mailbox greeting o
leaving a message so you can speak with the caller.
a caller is interrupted, the first part of the message 
remains in the mailbox. You can delete this message
your convenience. If Off-premise Message 
Notification is on, the message causes Enterprise Ed
Voice Messaging to call the Off-premise Notification 
number immediately.

Call Record ƒ·°· Records a telephone call from your Enterprise Edge 
telephone. The message is left in your mailbox.

11
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Programming a memory button
To simplify setup and administration tasks, we recommend that you program
memory buttons for the feature codes you use most often. The most frequently
Enterprise Edge Voice Messaging feature codes are:

• Open Mailbox - Feature 981

• Forward to Enterprise Edge Voice Messaging - Feature 984

• Transfer - Feature 986

• Interrupt - Feature 987

To program a memory button:

Label the buttons with the feature code description using the paper labels pro
with your Enterprise Edge telephone.

Note: We recommend that you program a memory button with the Enterprise
Edge Voice Messaging extension.

1. Press ƒ•‹.

2. Press a programmable button.

3. Press ƒ and enter the feature code 
number.

4. Repeat steps 1 through 3 for each Enterprise 
Edge Voice Messaging feature code you want
to program.

Press a button
QUIT

Programmed
Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide P0911620 Issue 02



Section V - Custom Call Routing (CCR)
• Overview of Custom Call Routing

• Building, saving, and assigning a CCR Tree

• Changing or deleting a CCR Tree
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Overview of Custom Call Routing

This chapter contains general information about Custom Call Routing (CCR) 
prepares you, the System Administrator, for the subsequent chapters on build
changing and deleting a CCR Tree. This chapter contains:

• an overview of how CCR works

• terms and definitions

• examples

• planning and designing a CCR Tree

How CCR works

After you assign a CCR Tree, callers hear the CCR Home voice prompt 
immediately after the Company Greeting instead of the Automated Attendant
Custom Call Routing (CCR) offers callers a more sophisticated menu and a w
range of options than the Automated Attendant menus.

A caller navigates through CCR using their telephone dialpad. By selecting a
option from the prompts that you create, callers can:

• play an information message

• leave a message in a mailbox

• transfer to an extension or an external number

• access another menu

Note: Set up mailboxes and Greeting Tables before designing and building t
CCR Tree.

12
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Custom Call Routing overview

When you build a CCR Tree, you start by programming the options in the Ho
node. If the Home node is a menu, up to eight options can be included.

You record a voice prompt or import a voice file that informs callers of the Ho
node menu options.

When a caller makes a selection from the Home node menu (by pressing a s
button) the caller can access an information message, mailbox, transfer, or an
menu below the Home node menu.

If the Home node is an Information node, the caller disconnects after the 
Information Message plays.

As System Administrator, you can program up to eight CCR Trees. After you
program a CCR Tree, you must assign the Tree to a Greeting Table. For mor
information, refer to Greeting Tables on page 32.

Automated Attendant

answersanswers
attendant

Company Greeting
plays

Custom Call Routing

Home node option(s) play 

Automated Attendant
 Menu options play

Incoming call
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Terms and definitions
The following terms are introduced in this section.

Term Definition

Assigned Key Key or button that the caller is prompted to press to access a node.

Home node Node associated with the first CCR Tree recording the caller hears 
they hear the company greeting. The Home node appears below the
icon. A Home node can be either a Menu node or an Information nod
in the CCR Tree. 

Icon Indicates the type of node including Menu, Transfer, Mailbox, and 
Information. There are also icons for a warning or an error if the node
incomplete or in error.

Information Mailbox Provides a caller with information about goods or services available
from your company. An Information Mailbox lets an end-user 
department keep the information current by logging on and changing
the Information Mailbox greeting.

Information node Does not have a mailbox allocation and is changed only in Enterpri
Edge Voice Applications Manager. To callers, an Information node is
the same as an Information Mailbox.

Mailbox node Lets a caller access a mailbox. Callers who select a Mailbox node 
transfer to a mailbox to leave a message or listen to an Information 
Mailbox. An Information Mailbox node plays a prompt to the caller. 
Note that a Mailbox node refers to a Mailbox but does not set up the
mailbox. Set up mailboxes before you design and build a CCR Tree.

Menu A voice prompt you record that provides a caller with a menu of up t
eight options.

Menu node A voice prompt you record that provides a caller with a list of up to 
eight options. Use a Menu node to create another level of tree depth
the tree.

Next Action Determines where the call is directed after the caller listens to an 
Information message or uses a mailbox. The three possibilities for N
Action are:
- Previous: returns the caller to the previous menu
- Home: returns the caller to the Home node
- Disconnect: disconnects the call

You can assign Next Actions only to Information nodes and Mailboxe

Node There are several types of nodes. There are Root nodes, Menu nod
and leaf nodes. A Root node is the beginning of a CCR Tree to whic
Home node is added. Menu nodes can support other Menu nodes a
leaf nodes. Leaf nodes cannot support Menu nodes. A total of eight s
nodes can be added to a Menu node. A sub-node belongs to a Menu
node and can include Menu nodes or leaf nodes.

Root node The beginning of a CCR Tree, represented by a tree icon. A new T
consists only of the Root node until you create a Home node.

Transfer node Is assigned a one-digit number that callers press to transfer to an 
extension or external number.

Tree A collection of nodes organized in a tree structure.

Tree depth As nodes are added to a CCR Tree, the Tree depth increases. The
level of Tree depth is the Home node. The maximum Tree depth is 1
nodes.
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Planning and designing a CCR Tree
Planning and designing a CCR Tree involves:

• determining frequently requested departments

• determining frequently called extensions

• making a list of goods and services to be promoted in Information messag

• selecting mailboxes to be assigned to Mailbox nodes

• determining Next Actions

• designing the CCR Tree template in the Enterprise Edge 2.0 Voice Messagin
Programming Record. Photocopy this record and use the photocopy as an 
outline as you proceed through this section.

• recording the prompts and messages

By default, a caller can press · to hear prompts in the Alternate Language, or ‚ 
to reach an Operator. Record the options as part of the Home node menu vo
prompt so that the caller is aware of these options.

About the CCR Tree structure
After the Company Greeting, a caller hears the Home voice prompt at the top o
CCR Tree. You create the Home node by adding a node to the Root node. The
node appears as a tree icon in the CCR x - Editor window.

When the Home node is an Menu node

You can set up a CCR Tree so that callers who select an option from the Home
menu can access another menu, leave a message, transfer to an extension o
external number, or listen to an Information Mailbox message.
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When the Home node is an Information node

You can set up the Home node to play an Information message. For example

“Come celebrate with us! It’s time for the Ideal Office Machines annual get-to
know-our-customers picnic. The annual picnic is on the first Sunday in Augus
from 1:00 to 5:00 p.m. in Central Park. See you there.”

If the Home node is an Information node, the caller disconnects automatically a
end of the message. The other Next Action types do not apply.

Recording an Alternate Language Home node menu voice prompt

If you record an Alternate Language Home node menu voice prompt, you mu
inform callers of the Alternate Language option. When you record the Primar
Language Home node menu prompt, speak in the Alternate Language and te
caller to press · if they wish to hear the message in the Alternate Language. 
Mention that they can press ‚ to transfer to the attendant. For example:

“To hear this message in (the Alternate Language), press ·. To place an order, 
press ⁄. To add your name to our mailing list, press ¤. To reach our sales 
department, press ‹. To speak with our Customer Service Representative, 
press ›. To speak with our attendant, press ‚.”

Menu sub-node 

A menu sub-node includes a voice prompt you record to provide a caller with
another list of options. A menu sub-node is created by adding a Menu node t
Menu node. A menu sub-node is assigned a single-digit number that appears
menu. A total of eight sub-nodes can be added to a Menu node. For example
the Home node menu, the caller presses ‹ to reach the Sales department and hea
the sub-node options:

“To place an order, press ⁄. To add your name to our mailing list, press ¤. To 
speak with our Customer Service Representative, press ‹. To speak with our 
attendant, press ‚.”

Information node

An Information node accompanies a message you record to provide a caller 
information about goods or services available from your company. This mess
can provide callers with information about sales, specials, company events, 
business hours, price lists, shipping times or even the weather. An Information
is assigned a single-digit number that is announced in a menu (unless the 
Information node is the Home node). When callers press this number, the 
Information message plays automatically. For example:

“We are pleased to announce the arrival of the new FaxEasy line of FAX mach
FaxEasy produces top quality FAX images at an affordable price, and is easy
operate.”
P0911620 Issue 02 Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide



108  Overview of Custom Call Routing

. The 
 a 
 

one, 
mber 

. A 
en a 
or 

 an 
Next 
Leave Message

The Leave Message option lets a caller access a mailbox to leave a message
Leave Message option is assigned a single-digit number that is announced in
menu. When callers press this number, the caller transfers automatically to a
mailbox to leave a message. An example of a Mailbox Greeting is:

“You have reached the Ideal Office Machines Order Desk mailbox. After the t
please leave your name, address, phone number, and the item name and nu
you want to order. Thank you.”

Transfer

A Transfer option lets a caller transfer to an extension or an external number
Transfer option is assigned a single-digit number that appears in a menu. Wh
caller presses this number, the caller transfers automatically to an extension 
external number.

Next Action
Next Action determines the destination the caller is sent to after they listen to
Information message or leave a message in a mailbox. The three options for 
Action are:

• Previous: returns the caller to the previous menu

• Home: returns the caller to the Home node

• Disconnect: disconnects the call
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Building, saving, and assigning a CCR Tree

Overview
This chapter contains the instructions needed to create, save and assign a CC

The specific topics in this chapter include:

• Beginning to build a new Tree

• Recording the Home node voice prompt

• Adding a Menu sub-node

• Adding an Information node

• Adding a Mailbox node

• Adding an internal Transfer node

• Adding an external Transfer node

• Saving a CCR Tree

• Assigning a CCR Tree

• Testing a CCR Tree

Tools and materials
To have a clear record of the CCR Tree you intend to create, first complete th
appropriate section of the Enterprise Edge Voice Messaging Programming Reco 
and have it handy during the programming.

Beginning a new CCR Tree and recording the Home node voice prompt
After you design your CCR Tree, the first step is to create a new Tree, then c
a Home node (either a Menu node or an Information node). If the Home node
Menu node, you can record the Home node voice prompt and then add:

• a Menu sub-node

• an Information node

• a Mailbox node

• a Transfer node

If the Home node is an Information node, you can record a voice prompt.

After you complete these steps, you must save the Tree. You must complete
save the CCR Tree before you can assign it.

When you start to build a CCR Tree, you can save the Tree at any time and co
working on it later. For more information about saving a Tree, refer to Saving a 
CCR Tree on page 117.

13
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Beginning to build a new Tree
Beginning to build a new Tree is as simple as clicking the CCR menu, clickin
New, and creating a Home node. From this node you can build a new CCR T

To begin to build a new Tree and record the Home node voice prompt:

1. Click the CCR menu and then click New.
The Tree - CCR Editor window, or Tree view, appears.

The newly created Tree shows only the Root node which is labeled Tree. 
Root node is highlighted. To continue to build the Tree, you must add a M
node or an Information node.

2. Click the Node menu and point to Add.
A list appears with the following available options: Menu and Information. 
Note: After you select Information, you cannot add Sub-nodes later. After 
select Menu, you can set up the CCR Tree so the caller can access more
one option.

3. Click Menu or Information .

4. Double-click the new Home node.
The Properties - Menu Node or the Properties - Info Node dialog box app
with the updated Tree view behind it.

5. In the Caption box, type a caption name, such as List of options, if the Home 
node is a menu.

6. To record the Home node voice prompt or select a previously recorded 
prompt, follow the steps in Recording a greeting or prompt from your 
telephone handset on page 27 to record a prompt from your telephone hand
or
follow the steps in Recording a greeting or prompt from your PC on page 28 
to record a prompt from your PC
or
follow the steps in Locating a previously recorded greeting or prompt on page 
28 to select a previously recorded prompt.

For information about saving a Tree, refer to Saving a CCR Tree on page 117.
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Adding a sub-node to a Menu node
After you create a CCR Tree, the first step in building the Tree is to assign op
to the Home node menu. If there are more choices than fit conveniently in the H
node menu, you can create one or more sub-node menus. Add a Menu node t
Home node menu.

Remember that if the Home node is an Information node, you cannot add a s
node and the call disconnects automatically after the message plays.

After you determine how many options you want to offer in a menu, you must
determine where the option directs the caller.

After you assign a Menu sub-node, you must next assign another set of optio
the next level of tree depth. Options for each menu can be another Menu, an
Information Mailbox, a Transfer, or a Leave Message option. You can assign 
eight options to each menu.

The Menu sub-node gives callers single-digit access to another list of options
your Tree is designed to progress to a second level, you must add a Menu sub
on the first level to inform the caller of further options. For example, if your Ho
node menu says:

“To place an order, press ⁄. To add your name to our mailing list, press ¤. To 
reach our sales department, press ‹. To speak with our attendant, press ‚.”

The caller can to press ⁄ and hear more options, such as:

“To hear our weekly specials, press ⁄. To speak with a clerk at the Order Desk
press ¤.” 
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Adding a Menu sub-node

To add a new Menu sub-node:

1. Click the CCR menu, point to Open and then click the Tree that you want to
add a sub-node to.
The Tree x - CCR Editor window appears.

Note: x is a variable that represents the Tree number after the Tree is sa

2. Click the Menu node that you want to add a sub-node to.

3. Click the Node menu, point to Add, and then click Menu.
An error message appears if the menu you select has the maximum numb
sub-nodes.

4. Double-click the new node.
The Properties - Menu Node window appears.

5. In the Caption box, type a caption name.

6. To record the Primary and Alternate prompts, follow the steps in Recording a 
greeting or prompt from your telephone handset on page 27 to record a 
prompt from your telephone
or
follow the steps in Recording a greeting or prompt from your PC on page 28
or to record a prompt from your PC
or
follow the steps in Locating a previously recorded greeting or prompt on page 
28 to select a previously recorded prompt.

7. In the Assigned Key list box, the lowest available Assigned Key number for
the Tree is shown. You can change the number to re-order the menu if 
required.

8. Click the OK  button.
The node is created.

You can continue to build the Tree and add more options, finish building the T
and save it, or save the Tree now and add to it later.
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Adding an Information Mailbox 
You can use the Information Mailbox to provide callers with information abou
sales, specials, company events, business hours, price lists or even the weat

To add an Information Mailbox:

1. Click the CCR menu, point to Open and click the Tree that you want to add 
an Information Mailbox to.
The Tree x - CCR Editor window appears.

2. Click the node that you want to add an Information node to.

3. Click the Node menu, point to Add, and then click Information .

4. Double-click the new node.
The Properties - Info Node dialog box appears. The messages that appea
the bottom of the Properties - Info Node dialog box contain tips and 
information.

5. In the Caption box, type a name for the Information Mailbox, such as Store 
Hours and Directions.

6. To record the Primary and Alternate prompts, follow the steps in Recording a 
greeting or prompt from your telephone handset on page 27 to record a 
prompt from your telephone
or
follow the steps in Recording a greeting or prompt from your PC on page 28
or to record a prompt from your PC
or
follow the steps in Locating a previously recorded greeting or prompt on page 
28 to select a previously recorded prompt.

7. At the Next Action option, select either Home, Disconnect or Previous.

• Previous: returns to the Previous menu

• Home: returns the call to the Home node voice prompt

• Disconnect: disconnects the call

An exception to this occurs if an Information Mailbox is the Home node. T
call disconnects after the Information message plays.

8. The Assigned Key list box displays the default number for the Assigned Ke
Click the OK  button to add the Information Mailbox. The node is created. 
You can continue to build this Tree and add more options, finish building t
Tree and save it, or save the Tree now and add to it later.
P0911620 Issue 02 Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide



114  Building, saving, and assigning a CCR Tree

 a 
. You 
.

be 

 

pear 

o. 

y.

ding 
Adding a Mailbox node
Adding a mailbox node provides a caller with a mailbox where they can leave
message or listen to an Information Message, depending on the mailbox type
create a mailbox by giving it a Path number and assigning a mailbox number

Before you assign a mailbox to receive callers’ messages, the mailbox must 
initialized.

To add the mailbox in which callers can leave messages:

1. Click the CCR menu, point to Open, and then click the Tree you want to add
a mailbox node to.
The Tree x - CCR Editor window appears.

2. Click the node that you want to add a mailbox node to.

3. Click the Node menu, point to Add, and then click Mailbox .

Double-click the new node.
The Properties - Mailbox Node dialog box appears. The messages that ap
in the bottom of the Properties - Mailbox Node dialog box contain tips and 
information.

4. In the Mailbox box, type the mailbox number you want to direct the caller t
If you do not know the mailbox number, click the Directory  button. 
The Select Mailbox dialog box appears.

5. Click the mailbox number you want and click the Select button.
The Properties - Mailbox Node dialog box appears.

6. At the Next Action option, select either Home, Disconnect or Previous.

• Previous: returns to the Previous menu

• Home: returns the call to the Home node voice prompt

• Disconnect: disconnects the call

The Assigned Key list box displays the default number for the Assigned Ke

7. Click the OK  button to add the new Mailbox node.

You can continue to build this Tree and add more options, or you can finish buil
this Tree and save it. For more information about saving a Tree, refer to Saving a 
CCR Tree on page 117.
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Adding a Transfer
A Transfer directs a caller to an internal extension or an external number.

Adding a Transfer to an internal extension
To add a Transfer to an internal extension:

1. Click the CCR menu, point to Open, and then click the Tree you want to add
a Transfer to.
The Tree x - CCR Editor window appears.

2. Click the Menu node that you want to add a transfer node to.

3. Click the Node menu, point to Add, and then click Transfer.

4. Double-click the new node.
The Properties - Transfer Node dialog box appears. The messages that a
in the bottom of the Properties - Mailbox Node dialog box contain tips and
information.

5. In the Caption box, type the name of the where you are transferring the ca
to, for example New Car Sales.

6. At the Select option, select either Line, Pool, Intercom or Route Code.

7. In the Dial box, type the extension number.

8. The Assigned Key list box displays the default number for the Assigned Ke
The node is created. You can continue to build this Tree and add more 
options, finish building the Tree and save it, or save the Tree now and add
later.

9. Click the OK  button to add the new Transfer node.

Adding a Transfer to an external number
When Enterprise Edge Voice Messaging transfers a call using a CCR externa
transfer, two lines are used. An incoming line connects the caller to the CCR 
and an outgoing line transfers the caller to the external telephone number. Both
are used while the user connects to the external telephone number.

To optimize using Enterprise Edge Voice Messaging lines, the incoming line 
be used to make the external transfer. This type of transfer is called a Link tra

Note: A Link transfer can be performed only if the Enterprise Edge Voice 
Messaging lines are equipped with Link transfer capability. If a Link 
transfer is programmed for an external transfer and your Enterprise Ed
Voice Messaging lines do not support this feature, the call disconnects
Ensure you have Link transfer capabilities on your Central Office (CO) li
before programming this feature.
P0911620 Issue 02 Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide



116  Building, saving, and assigning a CCR Tree

ial 
er 

r to 

 

ear in 

ller 

 
r 

y. 
he 
To perform a Link transfer for a CCR external transfer you must add the spec
character £ before the telephone number. For example, the telephone numb
looks like:

£fififi⁄¤‹›

where:

fififi⁄¤‹› is the telephone number dialed

For more information about this feature, refer to the Enterprise Edge 2.0 
Installation and Maintenance Guide.

For important information on preventing unauthorized calls using outdial, refe
Outdial route on page 61.

To add a Transfer to an external number:

1. Click the CCR menu, point to Open, and then click the Tree you want to add
an external Transfer to.
The Tree x - CCR Editor window appears.

2. Click the node to which you want to add a transfer node. 

3. Click the Node menu, point to Add, and then click Transfer.

4. Double-click the new node.
The Properties - Transfer Node window appears. The messages that app
the bottom of the Properties - Mailbox Node dialog box contain tips and 
information.

5. In the Caption box, type a description of where you are transferring the ca
to, for example Sales Manager Cellular.

6. At the Select option, select either Line, Pool, Intercom or Route Code.

7. In the Dial box, type # and the external number. If your company uses line,
pool or route access codes, the code must precede the phone number. Fo
example, if you press 9 to access an outside line, then 9 must be the first 
number in the phone number.

8. The Assigned Key list box displays the default number for the Assigned Ke
You can continue to build this Tree and add more options, finish building t
Tree and save it, or save the Tree now and add to it later.

9. Click the OK  button to add the new Transfer node.
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Saving a CCR Tree
After you build a CCR Tree record the menus and messages, or any time afte
start building it, you can save the Tree as Tree 1 through 8. You cannot save th
if it has errors.You must save the Tree before you can assign it.

To save an open CCR Tree:

1. In the Tree x - CCR Editor window, click the File menu, and then click 
Save.
The Save As dialog box appears.

2. Select the location for the stored CCR Tree in the Save In box.

3. In the File name box, type the number for the Tree.

4. Click the Save button.

After you build and save a CCR Tree, you can assign it. Before you assign a 
to a Greeting Table, test it to make sure it is working correctly. For more 
information about testing, refer to Testing a CCR Tree on page 117.

Assigning a CCR Tree
Before incoming callers can access a CCR Tree, you must assign lines to Gre
Table 1, 2, 3 or 4. For information about assigning lines to Greeting Tables, re
Assigning a Greeting Table and the number of rings before Enterprise Edge V
Messaging answers on page 40.

After you assign lines, you can assign the Tree to a Greeting Table.

To assign a Tree, you must:

• assign the Tree to Greeting Table 1, 2, 3 or 4.

• make the Tree number a destination in the Caller ID Table. Your company 
subscribe to Caller ID services before you can use this feature. For inform
about Caller ID Tables, refer to Setting up an Automated Attendant on page 31.

Testing a CCR Tree
After you a build, save and assign a CCR Tree to a Greeting Table, test the C
Tree. To verify the Tree, call the company number and test each node. Make
that:

• the Home node routes the call as designed

• each transfer routes the caller to the intended destination

• each prompt provides the correct information

• messages are courteous and easy to understand
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Changing or deleting a CCR Tree

Overview
After you create and assign a CCR Tree, you can modify it to reflect changes in
company or you can save an existing CCR file to another file and customize 

This chapter describes how to:

• save a CCR Tree file to another file

• disable a CCR Tree

• change a Home node or Sub-node

• move a node

• delete a Menu on a CCR Tree

• delete a CCR Tree

Tools and materials
To have a clear record of the options you intend to change, first make change
the appropriate section of the Enterprise Edge 2.0 Voice Messaging Programmin
Record and keep it handy during the programming changes.

Precautions
Before you make changes to a CCR Tree, you must disable the Tree.

Saving a CCR Tree to a file
To save a CCR Tree to a file:

1. Open the Tree you want to save.

2. On the Tree x - CCR Editor window, click the File menu, point to Save As, 
and then click the Tree you want to save the Tree file to, or click File.
The Save As dialog box appears.

3. In the File name box, type the name of the file.

4. Click the Save button.

Note: To re-open the file, click the CCR menu, point to Open and click File. 
The Open dialog box appears. Select the file, which has a .CCR 
extension and then click the Open button.

14
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Disabling a CCR Tree
Before you make any changes to an active CCR Tree you must ensure service
disrupted by removing any references to the CCR Tree from the Greeting Ta
and the Caller ID Tables.

To remove references to a CCR Tree from a Greeting Table:

1. Click the Auto Attendant menu, point to Greeting Table and click the 
number of the Greeting Table that references the CCR Tree. If you don’t 
know which Greeting Table references the CCR Tree check each Greetin
Table.
The Greeting Table Setup dialog box appears with the Routing tab open.

2. From the CCR Tree list box, select a different CCR Tree or select None.

3. Click the OK  button.
Repeat steps 1 through 3 for each Greeting Table that has the CCR Tree
want to disable assigned to it.

To remove references to a CCR from a Caller ID Table:

1. On the Auto Attendant menu click CLID Table Admin .
The Calling Line Identification dialog box appears.

2. Find any entries that refer to the CCR Tree.
These entries are identified by the word "Table" in the Type column and s
the Tree number in the Value column.

3. Click the Change button or the Delete button to change or delete these table
entries.

Changing the Home node menu
If you add a menu to the Root node (which appears as the image of a tree) w
Home node already exists, a new Home node menu is created with the former 
node as the first assigned sub-node.

Note: Changes cannot be undone unless you close the CCR x - Editor windo
without saving changes.
Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide P0911620 Issue 02



Changing or deleting a CCR Tree  121

e 

t 
 to 

Menu 
 with 

u.
Changing a Sub-node 
To change a sub-node:

1. Click the CCR menu, point to Open, and then click the Tree that contains th
sub-node you want to change.

2. Click the sub-node you want to change.
If you click the Home node, the Assigned Key is not displayed.

3. Click the Node menu, and then click Properties.
The Properties - Menu Node dialog box appears.

4. Depending on the type of node you click, Primary Prompt and Alternate 
Prompt appear. You can change your prompt.

5. From the Assigned Key list box, choose the new Assigned Key number tha
you want to change the sub-node to. If you choose a key that is assigned
another node, the nodes exchange assignments.

6. Click the OK  button.

Moving a node
A node can be moved from one menu to another by dragging it onto the target 
node. The node is removed from the menu and inserted into the target Menu
its original assigned key or the first unassigned key.

Deleting a menu
To delete a menu:

1. Move the menu’s sub-nodes (if any) to a location in a higher level menu.

2. Click the Menu node you want to delete.

3. Click the Node menu.

4. Click Delete.
A message appears asking you to confirm your request to delete the men

5. Click the OK  button.
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Deleting a Tree
Before you delete a CCR Tree, make sure the Tree is disabled. For informati
about disabling a Tree, refer to Disabling a CCR Tree on page 120.

To delete a Tree after it is disabled:

1. Click the CCR menu, point to Delete, and then click the number of the Tree 
you want to delete.
A message appears that asks you to confirm your request to delete the Tr

2. Click the OK  button.
The Tree is deleted.
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Section VI - Maintenance and
Troubleshooting

• Enterprise Edge Voice Messaging Reports
• Enterprise Edge Voice Messaging Troubleshooting
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Enterprise Edge Voice Messaging Reports

Overview
This chapter describes Enterprise Edge Voice Messaging Reports and explain
to generate and print reports.

Use the following reports to view Enterprise Edge Voice Messaging programm
status and the available message time.

Report Contains

Directory Report A list of the mailbox owners in the Company Directory.

Numeric Mailbox Report A list of mailbox owners in order of mailbox numbers.

System Group List Report A list of Group Lists by number and name, including the names of the us
the list and their mailbox numbers.

Message Usage Report A list of the current storage available in minutes on the Enterprise Edge 

Mailbox Activity Report A list of daily and average mailbox statistics. You can generate this report
either an individual mailbox or all mailboxes.

Caller ID (CLID) Report A list of the daily CLID activity for the Enterprise Edge Voice Messaging 
System.

Dialing Translation 
Report

A list of the current settings of the Dialing Translation parameters and a list
all the entries in the Dialing Translation Table.

Alarm Report A list of the alarm messages collected in the Alarm log.

Custom Call Routing 
(CCR) Report

A list of the menus on the CCR Tree, assignments to the menus and any a
that need administering.

The Tree report must be accessed through the CCR Administration menu.

Enterprise Edge Voice 
Messaging Call Handling 
and Port Usage Report

A two-part report that summarizes inbound and outbound call activity and p
usage for the previous seven days.

Enterprise Edge Voice 
Messaging System 
Configuration Report

A four-part report that indicates how the system is configured. The informati
includes System options, lines, Greeting Tables, installed Enterprise Edge
Voice Messaging Options, General Networking parameters, AMIS networki
parameters and site table.

Fax On Demand usage 
report

A list of Fax On Demand requests for the previous seven days. Includes

the date, time, item requested, delivery fax number, and Caller ID of the

caller.

15
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Directory Report
This report shows information for mailbox owners listed in the Company Direct
and includes:

• the mailbox owner’s name, mailbox number

• the type of mailbox, extension,

• if the mailbox owner has their name in the Company Directory

• if the mailbox owner has a recorded mailbox greeting.

Note: The Subscriber list appears in alphabetical order.

Numeric Mailbox Report
This report shows all mailboxes in numeric order, including mailbox type and
“snapshot” of the mailbox at the time the report is run. The following informat
is reported:

• the mailbox number

• mailbox type

• mailbox name

• primary extension assigned (or Guest)

• Class of Service number

• total number messages in the mailbox

• total volume of messages rounded to nearest minute

• number of new messages (User mailboxes only)

• volume of new messages rounded to the nearest minute (User mailboxes

• Outdial parameter assigned (User and Fax On Demand mailboxes only)

• space for Information Messages to display additional information about th
mailbox

• if the owner had their mailbox locked for exceeding the number of incorre
password attempts

System Group List Report
This report shows the Group List number, the type of Group List, the Group L
name, the mailbox numbers included in the Group List, the mailbox owner na
and the type of mailbox. If FAX is installed, Fax Group Lists are also be show
Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide P0911620 Issue 02
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Mailbox Activity Report
This report shows the mailbox number, mailbox owner’s name, the last date o
access, and information about the messages left in a mailbox. This report is i
parts and covers mailbox usage over a period of seven days.

The starting point of this report is the last full day of activity. For example, if th
full day of activity is Tuesday, the report begins on Tuesday and goes back s
days to the previous Wednesday.

In part two of the Mailbox Activity Report, each line total indicates a cumulativ
average of the mailbox activity.

You can print this report for individual mailboxes or all mailboxes certified wit
Enterprise Edge Voice Messaging. When you print the Mailbox Activity Report
all the mailboxes, ensure the printer has enough paper. Because of the size o
report, print at night or during a slow time. To get the full benefit of this report, p
it on the same day each week and reset the statistics after each printing.

Caller ID (CLID) Report
A list of the daily CLID activity for the Enterprise Edge Voice Messaging Syst

Dialing Translation Report
This report lists the current settings of the Dialing Translation Parameters the 
and Output entries in the Dialing Translation Table.

Note: A “ *  ” character after a value signifies any digits in the phone number 
remain to be dialed. Enterprise Edge Voice Messaging automatically a
the “* ” character after every Input and Output value.

Alarm Report
This report shows the alarm messages in the Alarm log.

Custom Call Routing Report
This report shows the Tree number, the Greeting Table(s) the CCR Tree is ass
to, the date the Tree was last modified, and the Tree status. The report also s
the Path, type, description, destination, a seven day rolling count of the numb
calls received by the Tree and the number of times each path is visited. Print
Custom Call Routing Report on the same day each week to get a true represen
of CCR activity.

Ensure you generate this report before you modify a CCR Tree.
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Enterprise Edge Voice Messaging Call Handling and Port Usage Report
This two-part report summarizes inbound and outbound call activity and port u
on a seven day rolling basis. Use this report to identify volume and sources o
traffic, and to determine if additional system ports are needed.

Enterprise Edge Voice Messaging Call Handling and Port Usage Report Part 1
The Enterprise Edge Voice Messaging Call Handling and Port Usage Report P
includes the following information:

• Allocation: Minimum and maximum number of ports allocated to Enterpris
Edge Voice Messaging

• Port Status: Number of ports the customer has paid to use

• Percentage of Time All Enterprise Edge Voice Messaging Ports Busy: An 
asterisk ( * ) indicates periods in which at least one port is disabled

Enterprise Edge Voice Messaging Call Handling and Port Usage Report Part 2
This report shows the number of calls, total duration and average duration of
in minutes for the following categories:

• Incoming Calls: Internal, External and Total Incoming

• Outgoing Calls: Message Notification, AMIS Delivery, and Total Outgoing. A
outgoing calls are attributed to a single category. For example, the entire c
considered as Message Notification even if the call party logs on.

• All Calls: Number of calls, Total duration, and Average duration.

System Configuration Report
This multi-section report indicates how the system is currently configured. The
a section for each of the following aspects of the system:

• System options

• Lines

• Greeting tables

• Fax parameters

• General networking parameters

• AMIS networking parameters

• site table

System Configuration Report, Part 2
In the Greetings column, the list does not show greetings that are not recorde
not used in any Greeting Table. The Line Answering column of Part 2 contain
entries only for the lines for which the Answer parameter is Yes.
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System Configuration Report, Part 3
The following categories in Part 3 appear only if the General Networking 
Parameters and AMIS Networking Parameters are installed.

System Configuration Report, Part 4
The Site Table appears if AMIS is installed. Local site information is available
within the Site Table data structure, and does not appear in this report.

Fax On Demand Usage Report
This report lists all Fax On Demand requests on a seven complete day rolling 
and shows the date, time, item requested, delivery fax number and Caller ID o
caller.
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Enterprise Edge Voice Messaging 
Troubleshooting

Overview
This chapter on Enterprise Edge Voice Messaging troubleshooting is divided
the following sections:

• system trouble

• operating trouble

• Custom Call Routing (CCR) trouble

System trouble
System trouble is defined as problems that occur to more than one mailbox o
and to both internal and external callers.

Automated Attendant does not answer calls

1. Verify that you have assigned the lines to the Greeting Table, and the line
designated as Yes. This means that Enterprise Edge Voice Messaging is 
answer the line.

2. Possibly all the Enterprise Edge Voice Messaging channels are busy. Try
calling back. Your call is answered when a channel is available.

3. Verify that greetings 1 to 4 are recorded. These greetings default to the 
Greeting Tables and must be recorded for the Automated Attendant to ope
Refer to Setting up an Automated Attendant on page 31.

4. If the Enterprise Edge Voice Messaging channels are frequently busy, it 
indicates there is too much activity. Contact your advice line or sales 
representative.

Call display information is lost
The Automated Attendant must be set to answer after two or more rings for 
Enterprise Edge Voice Messaging to record call log information for an incomi
call. For information about setting the number of rings, refer to Enabling Touchtone 
Gate on page 41.

16
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The Automated Attendant transfers some callers to the General Delivery Mailbox
Enterprise Edge Voice Messaging requires a touch tone phone signal and a 
minimum voice level. Enterprise Edge Voice Messaging waits for a caller to 
respond. If a response is not received, the caller transfers to the Receptionist
designated Operator. If they are not available, the caller automatically transfe
the General Delivery Mailbox. The caller also transfers to the General Deliver
Mailbox if an extension does not have a mailbox.

For Enterprise Edge Voice Messaging to transfer calls correctly, each mailbox
have a unique extension. To verify that all mailboxes have a unique extension,
the Directory Report (Report 1).

Greetings are played at the wrong time of day
There are three possible causes for this problem:

1. The Business Open Status is set to No. Change the Business Open Statu
Yes. Refer to Setting the Operator Status on page 45.

2. The wrong greeting numbers are assigned to the Greeting Table.

3. The business hours are set incorrectly.

Greetings are played on the wrong line
To verify the line information is correct, refer to the Enterprise Edge 2.0 Voice 
Messaging Programming Record. If you find the information is incorrect, you mus
reassign lines to the Greeting Table. Refer to Programming which lines are 
answered by Enterprise Edge Voice Messaging on page 39.

A telephone cannot be forwarded to Enterprise Edge Voice Messaging
If you forward your incoming calls to Enterprise Edge Voice Messaging and t
display shows: Forward denied, possibly you are forwarding to the wrong 
extension. Use feature code 985 to display the correct extension for Enterprise
Voice Messaging and compare this number to the extension that your telepho
forwarded to.

Feature 981 produces a Log prompt on the Enterprise Edge display
If a Log prompt appears on the display, it can signify that the telephone does
have an assigned mailbox. If the extension does not have an assigned mailb
Enterprise Edge Voice Messaging requests both a mailbox number and a pas
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Mailbox owner is unable to reply to an external caller, use Off-premise Message 
Notification or Outbound Transfer

An Outdial route must be assigned before a Mailbox Owner can reply to an ext
caller using the Reply feature or use Off-premise Message Notification or 
Outbound Transfer. Before a Mailbox Owner can reply to a message from an
external caller, an Outdial route must be assigned and a Dialing Translation T
must be created.

The default for Outdial route is None. Until you assign a line, line pool or route c
as the Outdial route for a mailbox, the mailbox owner can use the Reply Featu
reply to calls from internal extensions only, Off-premise Message Notification
internal extensions only and Outbound Transfer for internal extensions only.

You can apply dialing restrictions to an Enterprise Edge telephone and the 
extensions connected to Enterprise Edge Voice Messaging. If you wish to res
outdialing of certain phone numbers, you must do one of the following:

1. Through Enterprise Edge programming, assign the dialing restrictions to t
Enterprise Edge extensions to which Enterprise Edge Voice Messaging is
connected. This restricts all outdialing calls including external transfers fro
CCR trees, Off-premise Message Notification and Outbound Transfers. W
assigning an Outdial route, all dialing is done by the extension to which 
Enterprise Edge Voice Messaging is connected, not by the Enterprise Edg
telephone. For additional information, refer to the Enterprise Edge 2.0 
Programming Operations Guide.

2. Through Enterprise Edge programming, assign the dialing restrictions to t
extension of the user. For additional information, refer to the Enterprise Edge 
2.0 Programming Operations Guide.

3. Through Enterprise Edge programming, assign the dialing restrictions to t
Enterprise Edge line(s) being used for outdialing. For additional informatio
refer to the Enterprise Edge 2.0 Programming Operations Guide.
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Operating trouble
The following conditions list some problems that can occur when operating 
Enterprise Edge Voice Messaging.

Personalized Greetings do not play
Personalized Greetings do not play when a telephone is on Call Forward Bus
Call Forward All Calls to the Enterprise Edge Voice Messaging extension. In th
cases, Personalized Greetings depend on Caller ID information that is receiv
before the second ring.

Personalized Greetings also do not play if the Auto Attendant is set to answer a
than 2 rings. The Primary or Alternate Personal Mailbox Greeting plays instea
Assign the number of rings to two or more.

Mailboxes are not accepting messages
A mailbox does not accept messages if the mailbox is not initialized.

Note: A mailbox cannot receive messages until it is initialized by the 
mailbox owner. Instruct owners to initialize their mailboxes.

Messages are being lost in a mailbox
If messages are being removed, check the message retention period in the m
Class of Service. To check the Class of Service, refer to Changing mailbox options 
on page 85.

A mailbox owner lost the mailbox password
A forgotten password cannot be recovered. The password associated with th
mailbox must be reset to the default password 0000. After a password is reset
default, the mailbox owner must change it in order to use the mailbox. To res
password, refer to Changing mailbox options on page 85.

A mailbox owner cannot access their mailbox  
Each mailbox is assigned a maximum number of incorrect password attempt
Class of Service. Enterprise Edge Voice Messaging records the number of inc
attempts since the last time the mailbox was successfully accessed. If the num
attempts is exceeded, the mailbox owner is “locked-out” and hears “This mailbox 
has been locked to prevent unauthorized access. Please contact your adminis
for assistance.” The mailbox cannot be opened again until the System 
Administrator resets the password. To reset a password, refer to Changing mailbox 
options on page 85.
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A mailbox is not in the Company Directory
Check to ensure the mailbox is initialized. If the mailbox is not initialized it do
not appear in the Company Directory. Check to ensure the Company Directo
Override for the mailbox is set to Yes. Refer to Changing mailbox options on page 
85.

Calls are answered by the wrong mailbox
Check to ensure that the correct extension is assigned to the mailbox.

A mailbox cannot be added to Enterprise Edge Voice Messaging
Ensure the mailbox is not already certified with Enterprise Edge Voice Messag
Mailbox numbers must be unique. Enterprise Edge Voice Messaging can sto
to 1,000 mailboxes. This number includes the Special Mailboxes. Refer to the
Enterprise Edge 2.0 Voice Messaging Programming Record.

You cannot enter a name for a mailbox
Names must be entered as last name, then first name and initial. All names m
have a comma (,) between the first and last name. The maximum length of the 
including the comma, is 16 characters. Refer to Changing mailbox options on page 
85.

Incomplete messages are received in a mailbox or “Message delivered” plays 
while recording a message, or a Enterprise Edge Voice Messaging session ends 
unexpectedly

Any of these situations can be due to a problem called Talk Off. Talk Off occu
Enterprise Edge Voice Messaging interprets certain voice patterns as Dual T
Multi Frequency (DTMF) tones. DTMF tones are produced when buttons are 
pressed on a touch tone phone. When you press a button on the dialpad, Ent
Edge Voice Messaging receives a DTMF tone and performs the correct opera
For example, after you enter your mailbox password, you can press £. The DTMF 
tone sent to Enterprise Edge Voice Messaging indicates you are finished ent
your password.

Some voice patterns are the same as DTMF tones. This can cause Enterpris
Voice Messaging to function incorrectly. For example, if in the middle of a mess
you say something that sounds the same as the DTMF tone created by pressi£, 
the recording session ends. Correcting Talk Off requires adjustments to your
Enterprise Edge Voice Messaging system.

You cannot create a Group List
The maximum number of Group Lists that can be created is 99. The Enterprise
Voice Messaging Group List must be enabled during installation. If the Group
feature is not enabled, you cannot create a Group List. To enable this feature
must reset Enterprise Edge Voice Messaging.
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Custom Call Routing (CCR) trouble
The following conditions describe problems that can occur while operating CC
Ensure that you check the CCR Tree Report regularly.

Note: For information about Reports, refer to Enterprise Edge Voice Messaging
Reports on page 125.

The Tree cannot be deleted
The Tree cannot be deleted while it is in use. The Tree must be disabled befo
can be deleted.

Note: For more information about deleting the Tree, refer to Deleting a Tree on 
page 122.

The Tree cannot be enabled
The Tree must be saved before it can be enabled, and it must be completed 
it is saved. To complete the Tree, ensure:

• The Tree contains the Home Menu node with an action node below it.

• If the Tree contains a Mailbox node, the mailbox is initialized.

The Mailbox is full
The mailbox is equipped with a Never Full Mailbox feature, which lets a calle
leave a message in the mailbox, even if the mailbox is “full”. The message is st
but cannot be accessed until the mailbox owner deletes some of the message
mailbox.

If more message time is required, the Class of Service of the mailbox can be
changed.

Deleting a mailbox
Do not delete a mailbox used in a CCR Tree. If you delete a Mailbox node mai
the messages automatically go to the General Delivery Mailbox.

For more information about the General Delivery Mailbox, refer to General 
Delivery Mailbox on page 54.
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Appendix A: Dialing Translation

Overview
Dialing translation is a process by which the number of an incoming call from
public network translates through a translation table into a number that can b
recognized and dialed on the local network, using the Reply feature.

For Dialing Translation to occur, you, as the System Administrator, must crea
Dialing Translation Table that recognizes the digits of an external number an
translates them into a number that can be dialed by the Enterprise Edge syste
Enterprise Edge system also consults the restrictions and schedules tables p
dialing the number.

The Dialing Translation Tables are necessary only for the Reply feature. Enter
Edge Voice Messaging does not require the tables in order to function norma

How the Dialing Translation Table works
A phone number is derived from information attached to an incoming Caller I
message. The number is then searched for by Enterprise Edge Voice Messag
the Dialing Translation Table. If the leading digit or digits of the phone numbe
match a Dialing Translation Table Input value (the number Enterprise Edge V
Messaging searches for in the Dialing Translation Table), the Output value is
substituted for the Input value. This change results in a phone number that ca
dialed on the local network. Changing the number usually involves removing 
area code or inserting an access code, based on the dialing rules of the local
network. For example, if a local number is prefixed with the long distance code
it is removed by the Dialing Translation Table.

The Dialing Translation process is immediate so calls do not take any longer to
Some phone numbers do not need to be changed before dialing. Enterprise E
Voice Messaging functions without a Dialing Translation Table except that th
Reply feature cannot be used.

Phone number translation
The Dialing Translation Table must define each possible case where a chang
needed to allow the number to be on the local network.

The Dialing Translation Table changes Network extensions into numbers tha
be dialed on the local network. The Network extension form of a phone numb
the usual form in which the number appears. For example, the phone numbe
555-5050, in its Network extension form, must be translated into a number tha
be dialed on the local telephone network. The Dialing Translation Table follows
rules required to make the call.
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The following three tables are examples of Dialing Translation Tables and how
function. Every Dialing Translation Table entry consists of an Input value colu
and an Output value column. The values in the Input column represent the le
digits of the Network extensions which, if matched, are replaced by the 
corresponding value in the Output column. The “*” character shown after a va
signifies any digits in the phone number that remain to be dialed. Enterprise E
Voice Messaging automatically adds the “*” character after every Input and Ou
value.

A phone number either matches or does not match a specific Input value.

A sample Dialing Translation Table from a site in metropolitan Toronto is sho
below.

 Sample Dialing Translation Table

A sample Dialing Translation Table from a site in Mountainview, California.

Sample Dialing Translation Table

INPUT OUTPUT Explanation

011* 011* The Table does not attempt to translate international phone numb

416* * The Table removes the 416 area code and dials all calls as 7 digi

905206*

90527*

etc.

 (135 more 
entries)

905206*

90527*

etc.

 (135 more 
entries)

These telephone exchanges can be dialed as local (no long dista
charges) 10 digit calls from the 416 area.

905* 1905* All other 905 numbers not listed in the Input column above are lo
distance numbers and must be dialed as 11 digit long distance 
numbers.

* 1* Any numbers that start with digits other than 011, 416 and 905 are
long distance, and have 1 added as a prefix.

INPUT OUTPUT Explanation

The Dialing Translation Table is empty. The local network in 
Mountainview supports 10 digit national dialing with recognized 
long distance charging.

In situations like the Mountainview example, there is no need to 
build a Dialing Translation Table.
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A sample Dialing Translation Table from a site with area code 206 near the bo
with area code 360.

Sample Dialing Translation Table

Network Access
The Dialing Table Translation results in a number that can be dialed on the lo
network. The final step is to prefix any digits required to reach the local netwo
from your Enterprise Edge system. For systems that are behind a PBX or PA
typically in North America · must be prefixed to the phone number. For syste
attached to Central Office (CO) lines no digits need to be prefixed.

Dialing Translation Parameters
The Dialing Translation process is controled by four parameters. These param
are:

• Long distance access code (Lg dst ac)

This prefix, if specified, is removed from any numbers entered by the subsc
if it is not needed to make the call. This simplifies the creation of the Dialin
Translation Table. For North America, set the long distance access code 
The default for this parameter is none. The field for this parameter is a 
maximum of 1 digit.

• Area code (Area cd)

If the phone number entered appears to be missing an area code, an area 
prefixed to the number. The area code is considered missing if the numbe
fewer than 10 digits. The default for this parameter is none. The field for th
parameter is a maximum of 6 digits. If this parameter is set to none, then no
code is prefixed to the phone number.

INPUT OUTPUT Explanation

011* 011* The Table does not attempt to translate international phone numbers.

20644*

206626*

etc.

(40 more 
entries)

44*

626*

etc.

(40 more 
entries)

Due to the site location, some calls can be dialed as local 7 digit 
numbers.

206* 1206* All other 206 numbers require 11 digit long distance dialing.

360224*

360227*

360472*

360224*

360227*

360472*

These 360 numbers can be dialed as 10 digit local numbers...

360* 1360* ... but all other 360 numbers are 11 digits long distance numbers.

* 1* All numbers starting with other than 011, 206 and 360 are long 
distance and have 1 added as a prefix.
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• Access code (Access cd)

In North America, the access code is usually 9. This number is prefixed to
numbers after Translation to access the local telephone network. If Enterp
Edge Voice Messaging is attached directly to CO lines, set the Access Co
none. The default for this parameter is none. The field for this parameter i
maximum of 2 digits.

• Reply translation (Reply trans)

If set to N (no), the user must manually trim the CLID message information
the number to be dialed on the local network. For more information, refer 
Replying to a message on page 73. If the reply translation is set to Y (yes), th
the Reply feature uses the Dialing Translation Table to dial the call. The de
for this parameter is N.

To make it easier for subscribers, set the Reply Translation to Y if a Dialing 
Translation Table is created. If a Dialing Translation Table is not created, set
Reply Translation to N.

Setting the Dialing Translation Parameters
Setting the Dialing Translation Parameters makes it easier to build a Dialing 
Translation Table. It is not a prerequisite to set the Dialing Translation Param
to operate Enterprise Edge Voice Messaging.

To set the Dialing Translation Parameters:

1. On the Options menu click Dialing Translation Table.
The Dialing Translation Table dialog box appears.

2. Click the Parameters button.
The Dialing Translation Parameters dialog box appears.

3. Type the Long Distance Access Code, Area Code, Access Code and sele
either Yes or No for Reply Translate.

4. Click the OK  button.

5. Click the Close button.
Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide P0911620 Issue 02



Appendix A: Dialing Translation  143

utput 
e 
ry 
mber 

ime.
Building a Dialing Translation Table 
To create a Dialing Translation Table, you must enter an Input value and an O
value for each entry. The Input value is the number that Enterprise Edge Voic
Messaging looks up in the Dialing Translation Table. If the corresponding ent
matches, the Output value is substituted for the Input value. The resulting nu
is ready to dial on the local network. Refer to the Sample Dialing Translation Table 
on page 140.

To build a Dialing Translation Table:

1. Click the Options menu and then click Dialing Translation Table.
The Dialing Translation Table dialog box appears.

2. Click the Add button.
The Dialing Translation dialog box appears.

3. In the Input Value box, type the input value.

4. In the Output Value box, type the output value.
Repeat steps 2 through 4 for each Dialing Translation Table entry.

5. Click the Close button.

Reviewing entries in the Dialing Translation Table
You can review or check the entries in your Dialing Translation Table at any t

To review your Dialing Translation Table entries:

1. On the Options menu click Dialing Translation Table.
The Dialing Translation Table dialog box, containing the entries, appears.

2. After you review the Dialing Translation Table entries, click the Close button.
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Changing an entry in the Dialing Translation Table
After a Dialing Translation Table has been built, you can change the Output v
of an entry at any time.

You cannot change the Input value of an entry. You must delete the entry and c
a new entry with new Input and Output values. Refer to Deleting a Dialing 
Translation Table entry on page 144.

To change an entry in the Dialing Translation Table:

1. Click the Options menu and then click Dialing Translation Table.
The Dialing Translation Table dialog box appears.

2. Click the Dialing Translation entry you want to change.

3. Click the Change button.

4. In the Output Value box, type the new output value.

5. Click the OK button.
Repeat steps 2 through 5 to change any other entries in the Dialing Trans
Table.

6. Click the Close button.

Deleting a Dialing Translation Table entry
You can delete an entry in the Dialing Translation Table at any time. To find t
entry you want to delete, refer to Reviewing entries in the Dialing Translation Tabl 
on page 143.

To delete an entry in the Dialing Translation Table:

1. Click the Options menu and then click Dialing Translation Table.
The Dialing Translation Table dialog box appears.

2. Click the Dialing Translation entry you want to delete.

3. Click the Delete button.

4.  Click the OK button to confirm the deletion.
Repeat steps 2 through 4 for every entry you wish to delete.

5. Click the Close button.
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Appendix B: Enterprise Edge Configuration Tips

Overview
This appendix describes some Enterprise Edge configuration enhancements
maximize the efficiency of Enterprise Edge Voice Messaging.

Delayed answering by the Enterprise Edge Voice Messaging Automated 
Attendant

The Enterprise Edge Voice Messaging Automated Attendant can answer any
on specified Central Office (CO) telephone lines after a specified number of ri
Enterprise Edge Voice Messaging answers incoming calls if:

1. The Installer programs Enterprise Edge Voice Messaging to be the prime
telephone for one or more designated CO lines. The Enterprise Edge Del
Ring Transfer (DRT) feature transfers unanswered calls on these lines to 
Automated Attendant after the specified number of rings.

Note: The Enterprise Edge DRT feature applies only to incoming calls on
assigned line. It does not affect any extension calls between 
telephones.

Ringing lines and answer buttons
If two or more telephones have a ringing line appearance of the same incomi
telephone line, and one of these telephones is programmed with the Call For
All Calls (CFAC) or Call Forward No Answer (CFNA) features, then all incomi
calls on the incoming telephone line are directed to the Personal Mailbox of t
programmed telephone.

For example, if a marketing receptionist’s telephone has a ringing line appear
of the marketing director’s telephone, and the receptionist’s telephone is call 
forwarded to Enterprise Edge Voice Messaging, then all incoming call immedia
transfer to the receptionist’s Personal Mailbox. This is also true if the reception
telephone is CFNA to Enterprise Edge Voice Messaging and if the number of
specified rings on the receptionist’s telephone is fewer than the specified ring
the marketing director’s telephone.

Note: CFAC and CFNA do not affect calls on a telephone’s non-ringing lines. 
example, if a receptionist’s telephone has a non-ringing appearance o
another telephone’s CO line, and the receptionist’s telephone is CFAC
CFNA to Enterprise Edge Voice Messaging, incoming calls on this line
not affected.
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Ringing Answer Button
If one or more telephones have a Ringing Answer Button for another telephone
one of these is CFAC or CFNA to Enterprise Edge Voice Messaging, all incom
calls are directed into the Personal Mailbox of the call forwarded telephone.

If two or more of these telephones are CFAC to Enterprise Edge Voice Messa
all calls are directed to the Personal Mailbox of the telephone that is connecte
the lowest numbered station port on the Enterprise Edge system.

Using Call Forward All Calls (CFAC) and Call Forward No Answer 
(CFNA)

If a mailbox owner does not want to take any calls for a period of time, they c
forward their telephone to their Personal Mailbox using the Enterprise Edge C
feature. When forwarded, all calls to the mailbox owner’s extension transfer 
directly into their Personal Mailbox.

To call forward to a mailbox, press ƒ·°›.

To cancel call forward:

Press ƒ£›

or

press CANCEL

or

press ∞.

No other telephone on the Enterprise Edge system can have a ringing line 
appearance of the mailbox owner’s lines or a ringing answer button of the 
forwarded telephone.

Sample Enterprise Edge Voice Messaging setups
There are several ways to set up Enterprise Edge Voice Messaging in your 
company. How you choose to set up Enterprise Edge Voice Messaging depen
the type of Enterprise Edge Business Communication System you have, and
many CO lines you use.

This sample Enterprise Edge Voice Messaging setup describes four different
sample configurations and concludes with some useful application tips.
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Setting Up for a small company
The On Your Toes Dance Studio has a Compact Business Communication sy
The Installer programmed both Enterprise Edge and Enterprise Edge Voice 
Messaging. The Installer programmed Enterprise Edge Voice Messaging to b
Enterprise Edge Call Forward No Answer (CFNA) telephone for each extensi
This means that any call not answered by a mailbox owner transfers to their 
mailbox.

Each mailbox owner has buttons programmed for the Enterprise Edge Voice 
Messaging Leave Message and Open Mailbox feature codes. This allows ea
access to these frequently used features.

All of the employees have been assigned a mailbox number that is the same a
Enterprise Edge extension. All of the mailbox owners have initialized their 
mailbox, and recorded and selected a Personal Greeting.

For the purpose of this example, Enterprise Edge and Enterprise Edge Voice
Messaging work together in call handling.

The central receptionist

The On Your Toes Dance Studio’s receptionist handles all calls from the stud
published phone number. When the receptionist cannot answer the telephone 
four rings, the Automated Attendant answers the call. The receptionist is also
Enterprise Edge designated Operator. Whenever a caller presses ‚ to speak with 
the operator, the call transfers back to the receptionist.

Here is how On Your Toes Dance Studio’s communication system works.

The On Your Toes Dance Studio’s public phone number is 555-2468. The stu
subscribes to custom calling services from its telephone company and this nu
forwards to any available (non-busy) line in a group of six lines. All six lines app
on the receptionist telephone.

Enterprise Edge Voice Messaging is the Prime Set for each of the six lines. 
Enterprise Edge’s Delayed Ring Transfer (DRT) feature is used to forward 
unanswered lines to the Automated Attendant. The DRT to Prime is set to Yes
the DRT Delay is set to four.

Note: Delayed Ring Transfer is a Enterprise Edge system-wide call handling
feature. All lines on the Enterprise Edge programmed DRT to Prime ar
forwarded after four rings. In the Enterprise Edge Configuration, this is
done by setting the Prime Set of the line to the Enterprise Edge Voice 
Messaging extension.

Enterprise Edge Voice Messaging uses Greeting Table 1 to answer calls afte
rings. Depending on the time of day, different recorded greetings play for the
Morning, Afternoon, and Evening. When the Business Status is No, the Non-
business Hours Greeting plays.

Note: Lines must be assigned to a Greeting Table before the Greeting Table
greetings are used.
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Greetings have been recorded by the System Administrator and say:

Greeting No. 1 “Good morning. You have reached On Your Toes 
Dance Studio. The studio is closed at this time. Pleas
stay on the line to leave a message.” 
(The Enterprise Edge Voice Messaging voice prompt
play after the greeting. You can make Company 
Greetings up to five minutes long.)

Greeting No. 2 “Good afternoon. You have reached On Your Toes 
Dance Studio.”

Greeting No. 3 “Good evening. You have reached On Your Toes Dan
Studio.”

Greeting No. 4 “You have reached On Your Toes Dance Studio. The
studio is closed at this time. Please stay on the line to
leave a message.”

Greeting Table 1 automatically answers calls using greetings 1 through 4. Gree
1 through 4 play until the System Administrator assigns different numbered 
greetings.

When Greeting Table 1 was configured, English was chosen as the Primary 
Language.

The Costume Room

The Costume Room has one telephone with a Enterprise Edge Voice Messa
mailbox. Calls are directed to the Costume Room Attendant by the receptioni
the Automated Attendant. When the Attendant is not available, the caller is 
forwarded to the Costume Room mailbox. The mailbox primary message say

“You have reached the Costume Room. No one is available to take your call. P
leave your name and number and a brief message after the tone and we will r
your call as soon as possible.”

Setting Up for a medium sized company
The Bridge Stone Company is an engineering firm that has a Compact Enter
Edge Business Communication system. The Installer programmed both Ente
Edge and Enterprise Edge Voice Messaging. The Installer programmed Ente
Edge Voice Messaging to be the CFNA telephone for each extension. This m
that any call not answered by a mailbox owner transfers to their mailbox.

Each mailbox owner has buttons programmed for the Enterprise Edge Voice 
Messaging Leave Message and Open Mailbox feature codes. This allows ea
access to these frequently used features.
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All employees are assigned a mailbox number that is the same as their Enter
Edge extension. All mailbox owners have initialized their mailbox, and record
and selected a Personal Greeting.

When the receptionist is not available, Custom Call Routing lets incoming cal
route their call along a call path.

For the purpose of this example, Enterprise Edge, CCR and Enterprise Edge 
Messaging work together in call handling.

The central receptionist

Bridge Stone’s receptionist handles all calls from the published phone numbe
When the receptionist is unable to answer the telephone within four rings, the
Automated Attendant answers the call. The receptionist is also the designate
Operator. Whenever a caller presses ‚ to speak with the operator, the caller 
transfers to the receptionist.

Here is how Bridge Stone’s communication system works.

Bridge Stone’s public phone number is 123-1234. All lines appear on the 
receptionist’s telephone. Enterprise Edge Voice Messaging is the Prime Set f
each of the six lines. The Enterprise Edge Delayed Ring Transfer (DRT) featu
used to forward unanswered lines to the Automated Attendant.

Delayed Ring Transfer is an Enterprise Edge system-wide call handling feature
lines on the Enterprise Edge programmed with DRT to Prime forward after fo
rings. In the Enterprise Edge Configuration, this is done by setting the Prime S
the line to the Enterprise Edge Voice Messaging extension. The DRT to Prime
to YES, and the DRT Delay is set to four.

Enterprise Edge Voice Messaging uses Greeting Table 1 to answer calls afte
rings. Depending on the time of day, different recorded greetings play for the
Morning, Afternoon, and Evening. When the Business Status is No, the Non-
business Hours Greeting plays.

Greetings have been recorded by the System Administrator and say:

Greeting No. 1 “Good morning. You have reached Bridge Stone 
Engineering.” (The CCR Home Menu plays after the 
greeting. You can make Company Greetings up to fiv
minutes long.)

Greeting No. 2 “Good afternoon. You have reached Bridge Stone 
Engineering.”

Greeting No. 3 “Good evening. You have reached Bridge Stone 
Engineering.”

Greeting No. 4 “You have reached Bridge Stone Engineering. Our 
office is closed at this time. Please stay on the line to
leave a message.”
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Greeting Table 1 automatically answers calls using greetings 1 through 4. Gree
1 through 4 play until the System Administrator assigns different numbered 
greetings.

When the Greeting Table was configured, English was chosen as the Primar
Language.

Note: Lines used must be assigned to the Greeting Table before the Greeting 
greetings are used.

Following the Company Greeting the CCR Home Menu voice prompt plays. T
menu provides a list of single digit options to a caller. A caller, after listening to
Home Menu, selects an option by pressing a number on any touch tone phon
example:

“To speak to our customer service representative, press ⁄. To reach our sales 
department, press ¤. To reach our shipping and receiving department, press 
‹. To speak with our receptionist, press ‚.”

The Customer Service and Sales department

This department has two secretaries, two customer service representatives, t
sales agents, a sales manager, and a customer service manager. Enterprise
Voice Messaging is set up to answer all calls with callers selecting either cust
service or sales from the CCR Home Menu voice prompt.

Incoming calls for customer service transfer directly to the customer service 
receptionist. Incoming calls for sales transfer directly to the sales receptionist

The managers

Bridge Stone managers have a personal CO line that appears on their private
telephone and their receptionist’s telephone. The receptionists answer the 
managers’ calls, and then transfer the calls to each manager’s telephone.

If a manager is unavailable to take a call, the call rings back at the receptionist
The receptionist handles the call by asking the caller to leave a voice message
manager’s Personal Mailbox. If the caller wants to leave a message, the recep
transfers the caller using the Enterprise Edge Voice Messaging Transfer Fea
(Feature 986).

When Enterprise Edge Voice Messaging is set up in this manner, the Enterpr
Edge CFNA for the manager’s set is not used. The receptionist answers the 
manager’s calls and uses Enterprise Edge Voice Messaging’s Transfer Featu
transfer the caller to the manager’s telephone. Enterprise Edge Voice Messag
Transfer Callback Feature returns the call to the receptionist’s telephone if a 
manager is not available to take a call.

Note: The receptionist’s telephone has a ringing line appearance. This telep
cannot be forwarded to another telephone.
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Shipping and Receiving

The employees in this department share the same Enterprise Edge telephon
department uses one telephone line that is assigned to the loading dock. This
assigned to Path 3 of the CCR Home Menu.

The shipping and receiving department mailbox greeting informs callers they
leave a message or press ‚ to speak with the receptionist.

Feature Compatibility
This part of the appendix describes how Enterprise Edge features interact wi
Enterprise Edge Voice Messaging. The section is organized in alphabetical o
according to the Enterprise Edge feature.

Enterprise Edge ATA 2

An analog single-line set can be connected to Enterprise Edge Voice Messag
using the Enterprise Edge ATA 2 or an Analog Station Module. This type of s
working with DTMF tones, allows access to Enterprise Edge Voice Messagin
options through the dialpad only. There is no Message Waiting Notification 
availability.

Rotary dials cannot be used internally with Enterprise Edge Voice Messaging

Answer buttons

For information about Answer Buttons, refer to Ringing Answer Button on page 
146.

Autodial (internal)

All mailbox owners on the Enterprise Edge Voice Messaging system can prog
the Enterprise Edge Voice Messaging extension. The Enterprise Edge Voice 
Messaging extension is determined using feature code 985.

The System Administrator can use autodial for Busy Lamp Field (BLF) indicat
for all voice channels. This allows Enterprise Edge Voice Messaging channels
monitored during busy periods.

Automatic Set Relocation

Must be set to No when changing the Enterprise Edge Voice Messaging exte
and connections between the Enterprise Edge and the Enterprise Edge serve

Call Forward All Calls (CFAC)

Any ringing line or answer button appearance on a set forwards to the extens
specified by the call forwarded extension.

If CFAC is used a caller immediately transfer to the mailbox of the CFAC 
extension.
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Call Forward No Answer (CFNA)

Any ringing line appearance on a set is CFNA to the extension specified after
programmed number of rings.

CFNA is not applicable in an Automated Attendant application. If Delayed Rin
Transfer (DRT) is being used for Enterprise Edge Voice Messaging answerin
ensure that the number of rings for CFNA on any of the sets is equal to or hig
than the number of rings for DRT.

CFNA takes precedence over DRT and Transfer Callback if it has a lower num
of rings.

Camp On

The Camp On Feature cannot be used to access Enterprise Edge Voice Mess
If a user calls the extension and there is no answer, the user cannot invoke the
On Feature. Instead, advise the user to wait a few moments and try the Ente
Edge Voice Messaging extension again.

Changing extensions

Using Enterprise Edge configuration programming to change the Enterprise E
Voice Messaging extension is not automatically supported by Enterprise Edg
Voice Messaging. If you change the Enterprise Edge Voice Messaging exten
reboot Enterprise Edge Voice Messaging.

Delayed Ring Transfer (DRT)

To use Enterprise Edge Voice Messaging as a secondary line answering pos
set DRT:

1. Assign the Enterprise Edge Voice Messaging extension as the prime exte
for the specified lines that are to be DRT to Enterprise Edge Voice Messa

2. Set the Enterprise Edge DRT to Yes.

3. Set DRT Delay from one to six rings.

4. Assign a Greeting Table to each line that is to be DRT to Enterprise Edge
Voice Messaging.

5. Set the Enterprise Edge Voice Messaging Answer option to No for the lin
that are to be DRT to Enterprise Edge Voice Messaging.

If DRT is used for Enterprise Edge Voice Messaging Answering, and Enterpr
Edge telephones with a ringing line appearance forward to Enterprise Edge V
Messaging, a caller immediately transfers to the mailbox of the CFAC set.
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Disconnect Supervision

If the Enterprise Edge server has Line Disconnect Supervision and a caller han
after reaching the Automated Attendant, Enterprise Edge Voice Messaging 
immediately senses this and breaks the connection. This results in fewer ‘pha
messages in the General Delivery Mailbox and prevents Enterprise Edge Voi
Messaging ports from being occupied.

Do Not Disturb (DND)

Stops all tones and ringing to a set. When a call transfers to a set with DND 
activated, the call appears as a flashing indicator on an available line. The 
Automated Attendant transfers the caller to the mailbox associated with that 
telephone.

Feature timeout

Enterprise Edge Voice Messaging has a timeout of up to two minutes. This fe
is independent of the Enterprise Edge timeout.

Hold

A mailbox owner cannot put a session on hold. If the hold button is pressed d
a Enterprise Edge Voice Messaging programming session, Enterprise Edge V
Messaging disconnects, except when Automatic Hold is used to transfer a ca
a mailbox or an extension. Enterprise Edge Voice Messaging ignores Held Li
Reminder tones.

Intercom Numbers

An inside user can access Enterprise Edge Voice Messaging using an interco
button and entering the extension. Access to the Enterprise Edge Voice Mess
feature codes and “Message for you” indication requires an intercom button on th
set.

An intercom button is required to notify an extension of an incoming transfer.

Language choice

The Enterprise Edge Voice Messaging language capability is independent of
Enterprise Edge’s language selection for a set. Enterprise Edge Voice Messa
language availability is determined by the Class of Service assigned to a mai

Note: The Enterprise Edge Voice Messaging language option is enabled afte
mailbox owner starts a session.

Lines

If a line programmed for the Automated Attendant appears on a set, it rings w
Enterprise Edge Voice Messaging transfers the call. If a line programmed to 
answered by the Automated Attendant does not appear on a set, a call is trans
to an intercom line appearing on the intercom button.
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Message Send/Reply/Waiting

Any message notification left by an internal caller can be replied to using the 
Enterprise Edge Voice Messaging message reply options. After listening to a
message, a user can forward a copy of the message to another mailbox or ca
message sender.

Note: Replying to a message from an Enterprise Edge one line display phon
requires the user to press · after listening to the message.

Night Service

When Night Service is activated and the Enterprise Edge Voice Messaging p
extension is specified as the Night Ring extension for an incoming line, a call
immediately hears the Enterprise Edge Voice Messaging Automated Attenda

Prime Set (multiple)

When configuring lines, Enterprise Edge Voice Messaging can be designated 
prime extension. Enterprise Edge Voice Messaging answers with the Automa
Attendant.

Private line

When private lines are assigned to a set programmed to ring, CFNA to Enter
Edge Voice Messaging is answered by the set’s Personal Mailbox. If a private
is the only appearance on that set, Enterprise Edge transfers calls through th
intercom button.

Note: If the private line is not programmed to ring, CFNA is not activated.

Release button

Ends an Enterprise Edge Voice Messaging session or telephone call.

Ringing line preference

Ringing lines programmed to Enterprise Edge extensions are recognized by 
Enterprise Edge Voice Messaging. Features such as CFNA and CFAC to Ente
Edge Voice Messaging are not recognized by non-ringing lines programmed 
Enterprise Edge extension. Refer to the Call Forward No Answer (CFNA) on page 
152, Call Forward All Calls (CFAC) on page 151 and Answer buttons on page 151.

Selective Call Forward

Refer to Do Not Disturb (DND) on page 153.

Service Modes

The Service Modes feature allows the Enterprise Edge System to be program
to forward all incoming calls to Enterprise Edge Voice Messaging during spec
time periods, such as lunch time or nonbusiness hours. Enterprise Edge Voic
Messaging answers with the Automated Attendant.

Transfer Callback

Calls through the Automated Attendant that transfer to a extension without CF
are routed by Transfer Callback to Enterprise Edge Voice Messaging after th
designated number of rings. The CFNA/Transfer Callback feature is program
so that the fewest rings take precedence.
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Appendix C: Resetting Enterprise Edge 
Voice Messaging

Overview
This appendix describes how to reset Enterprise Edge Voice Messaging.

As System Administrator, you must reset Enterprise Edge Voice Messaging if
change the extension number length.

Resetting Enterprise Edge Voice Messaging
Resetting Enterprise Edge Voice Messaging erases all the Company Greetin
Greeting Table and mailbox information.

Before you reset Enterprise Edge Voice Messaging, make sure that you have a
of the current Enterprise Edge Voice Messaging setup. Refer to your comple
Enterprise Edge Voice Messaging Programming Record.

After you reset Enterprise Edge Voice Messaging you must:

• record Company Greetings. See Recording a Company Greeting on page 35.

• enter Greeting Table information. See Greeting Tables on page 32.

• add mailboxes. See Creating Mailboxes on page 77.

• initialize the Special Mailboxes. See Special Mailboxes: General Delivery and
System Administrator on page 63.

CAUTION
If you reset Enterprise Edge Voice Messaging all previous programming and 
any messages in the mailboxes are lost.
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To reset Enterprise Edge Voice Messaging:

1. Press ƒ·°¤.

2. Enter the operator password and then press OK.

Note: The default operator password is
fl‡‹‡¤°fl‡ (OPERATOR).

3. Press ⁄.

4. Enter ‡‹›fl‡°¤fifi (REINSTALL) 
and press OK.

Note: Do not make this password available to any 
users.

5. Press YES.

6. After you press YES, Enterprise Edge Voice 
Messaging starts to reset.
The display shows Resetting... and then changes 
to show the date and the time until the resetting is 
finished.

7. After the reset is finished, the display shows System 
ready and then Exit. After the programming is 
complete, the display automatically shows the time 
and the date.

Pswd:
 RETRY                      OK

Atdt avail:N
CHNG                     NEXT

Pswd:
RETRY                        OK

Reset database?
YES                             NO

Resetting...

System ready

Exit
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Glossary

AA

See Automated Attendant.

Administration

The tasks involved in maintaining the Enterprise Edge Voice Messaging 
Mailboxes, Greetings and set up configuration. Administration also involves se
up and maintaining the CCR Trees.

Alternate extensions

When a caller dials an extension that is programmed to have one or more alte
extensions, Enterprise Edge Voice Messaging rings at all of the sets simultane
The first set to answer accepts the call. The other sets cannot access the line
the Interrupt Feature (Feature 987) to access the answered line.

Alternate extensions are available only on User mailboxes.

Alternate Greeting

A greeting that is recorded for a Personal Mailbox and played only on except
occasions, such as absence.

Alternate Language

A secondary language used for greetings and prompts. To use an Alternate 
Language, you must enable the Bilingual Option. The Alternate Language ca
be the same as the Primary Language.

Attendant sign ON/OFF

A task performed by a company Receptionist or designated Operator that indi
to Enterprise Edge Voice Messaging when an Operator is available to answer

Automated Attendant

The Enterprise Edge Voice Messaging answering service that answers incom
calls with a Company Greeting, plays a menu of options to a caller, and perfo
call routing functions in response to a caller’s selections.

Blind Call

An incoming call where the caller transfers directly to the extension requested

Broadcast Message

A message that can be sent by the System Administrator. This type of messa
plays in all initialized Personal Mailboxes and plays immediately when the mai
is opened by the owner. It is deleted automatically after the mailbox owner lis
to the message.
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Business Status

A setting that overrides the schedule of the Greeting Table and plays the 
Non-business greeting until turned off.

CCR

Custom Call Routing.

Channel configuration

The number of channels on the Enterprise Edge Voice Messaging unit that a
designated for outcalling.

Class of Service

A Class of Service defines the values for the special features of a Mailbox. W
registering a mailbox, the System Administrator programs several special fea
at once by choosing the number from the Class of Service table that provides
level of service most appropriate for the user.

A mailbox cannot be added without a Class of Service.

Company Directory

The Company Directory is an internal voice list of the names of mailbox owne
with initialized mailboxes who are designated to appear in the directory.

Configuration

The tasks involved in setting up the different parameters of Enterprise Edge V
Messaging. For example, configuring the Central Office (CO) lines answered
Enterprise Edge Voice Messaging.

Configuring Enterprise Edge Voice Messaging lines

The tasks involved in determining which external lines are answered by Enter
Edge Voice Messaging and which Greeting Table is assigned.

Custom Call Routing Tree

Call Paths that let users select options to direct their calls along the paths you 

Default

The preset parameters for Enterprise Edge Voice Messaging.

Destination

On a CCR Tree, the Destination determines where the caller is directed after
listen to information or leaving a message in a mailbox. The Destination Type

• PREV: returns the caller to the Previous menu

• HOME: returns the caller to the Home Menu

• DISC: disconnects the call

Destinations can be assigned only to the Information Message and Leave Me
options.
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Display

A one-line or two-line display screen on an Enterprise Edge telephone that sh
Enterprise Edge Voice Messaging commands and options.

Display buttons

The three buttons that appear below an Enterprise Edge two line display disp
When pressed, these buttons select the specified Enterprise Edge Voice Mes
option.

Display Options

The choices available to a mailbox owner that appear on an Enterprise Edge
line display. Options appearing on the display can be selected using the disp
dialpad buttons.

Enterprise Edge ATA 2

An Enterprise Edge product that allows the connection of an analog device, su
a single-line telephone or a facsimile machine, to an Enterprise Edge system

Enterprise Edge Voice Messaging Programming Record

A booklet where you record Enterprise Edge Voice Messaging configuration 
CCR Tree programming information.

Envelope information

A date and time stamp that appears on all messages left in a mailbox. When 
message is left by another mailbox owner, envelope information includes the
message sender’s name.

Extensions

A two to seven-digit number that is used to reach a designated telephone.

Extension length

The number of digits in a Enterprise Edge extension and an Enterprise Edge 
Messaging mailbox number. The extension length ranges from two to seven d

Feature code

A unique three-digit code used to access Enterprise Edge Voice Messaging Fe
and options.

General Delivery Mailbox

One of the two Special Mailboxes that hold messages for individuals who are
assigned a Personal Mailbox.
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Greetings

There are three types of Enterprise Edge Voice Messaging Greetings: Comp
Greetings, Personal Mailbox Greetings and Information Mailbox Greetings. 
Company Greetings are played by the Automated Attendant to callers. Perso
Mailbox Greetings are played to callers who want to leave a message in a se
mailbox. Information Mailbox Greetings are played to describe goods or serv
available to callers.

Greeting Tables

A table for storing recorded Company Greetings, start times assigned to the 
greetings, and the lines that are answered by Enterprise Edge Voice Messag
There are four Greeting Tables.

Group Lists

A collection of mailbox numbers that are assigned a special Group number b
Enterprise Edge Voice Messaging. When a message is sent to a Group List, 
mailboxes in the list receive the message.

Guest Mailbox

A Guest Mailbox is a type of Personal Mailbox assigned to people who do not 
a permanent extension, but require a mailbox. These mailboxes receive and 
messages the same way that User Mailboxes do.

Home Menu

The Home Menu is the first CCR menu callers encounter after they hear the 
Company Greeting. The Home Menu provides a list of single-digit options to 
caller. A caller, after listening to the Home Voice Menu, selects the option by 
pressing a number on any touchtone telephone.

A Home Menu can be programmed to offer eight options. By default, Ø is 
reserved for reaching the Operator, and · offers the menu in the Alternate 
Language.

The Home Menu can also be a recorded Information Message that announce
information to a caller and disconnects the call when the announcement is fin

Home Menu Voice Prompt

A voice prompt that provides a list of number options. When pressed, these op
route a caller to: a sub-menu, an Information Message, a Leave Message opt
a transfer to an extension.

ICS

Integrated Communication System, an Enterprise Edge business telephone s

Information Mailbox

A mailbox that provides a caller with a message describing goods or services
available from your company. The Information Mailbox does not take messag
and does not have an extension associated with it.
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Information Message 

On a CCR Tree, an Information Message is a message you record to provide a
with information about goods or services available from your company. 
Information mailboxes must be created before the Information Message option
be added to the CCR Tree.

Initialize

Preparing a mailbox to receive messages, which includes changing a mailbo
default password, recording a Company Directory name, and recording Perso
Mailbox Greetings.

Initializing Enterprise Edge Voice Messaging

Preparing the Enterprise Edge Voice Messaging settings used in mailbox num
length and language preference.

Leave Message

The feature code used to leave messages in Enterprise Edge Voice Messagi
mailboxes.

Leave Message option

The Leave Message option on a CCR Tree provides callers with access to a m
so they can leave messages. A caller who selects this option is automatically
transferred to a mailbox to leave a message.

Level 

The Home Menu is on Level 0. As sub-menus are added, the caller progress
through the levels of the CCR Tree. Ten levels can be created (from 0 to 9).

Mailbox

A storage place for messages on the Enterprise Edge Voice Messaging syste

Mailboxes

Part of the Enterprise Edge 2.0 Voice Messaging Programming Record that 
contains mailbox information which includes mailbox number, assigned extens
mailbox owner’s name, and Directory Overrides.

Mailbox number length

The number of digits allowed in a mailbox number. The mailbox number leng
ranges from two to seven digits.

Mailbox Overrides

Mailbox Overrides are optional parameters in addition to the Class of Service
values. The Mailbox Overrides are: Include in Company Directory, Alternate 
Extensions, Express Messaging Line, Call Screening, Message Waiting 
Notification, and Outdial route.
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Menu

A menu is a voice prompt you record that provides a caller with a list of up to e
options. There is one default pre-recorded menu, the Automated Attendant M
that plays after the Company Greeting. You can replace this default menu wi
custom menu, or you can assign the CCR Home Menu to play instead of an 
Automated Attendant menu.

Message Delivery Options

Message sending options that are stamped onto a message. There are five M
Delivery Options: Normal, Certified, Urgent, Private and Timed. A Message 
Delivery Option can be assigned to a message after a user has selected a m
or after recording a message.

Message Waiting Notification

Message Waiting Notification provides a mailbox owner with a message 
notification Message for you on the display of their telephone. This Enterprise
Edge Voice Messaging Feature is a Mailbox Override.

Never Full Mailboxes

Your Enterprise Edge Voice Messaging mailbox is equipped with the Never F
Mailbox Feature, which allows a caller to leave a message in your mailbox, ev
the mailbox is “full”. The message is stored, but cannot be accessed until you d
at least one saved message.

Off-premise Message Notification

Allows you to direct your messages to any phone number, extension or to a p
This Enterprise Edge Voice Messaging Feature is part of the Class of Service

Operator

The Operator is the person whose extension rings when the caller is prompte
the Automated Attendant to “Press Ø for an operator”. If the Operator is not 
available, callers who request the Operator transfer to the General Delivery 
Mailbox.

In Class of Service, the Operator is also known as a Targeted Attendant.

Operator default extension

The Receptionist or Enterprise Edge Voice Messaging designated Operator’s
default extension. This default is preset to none, and must be changed to any
extension on the system.

Operator Status

The Enterprise Edge Voice Messaging setting that tells the system whether a
Receptionist or designated Operator is available.

Option

An Enterprise Edge Voice Messaging choice that is given to a user through v
or display prompts.
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Outdial route

The Outdial route determines which line or line pool the system uses when a
mailbox owner replies to a message left by an external caller.

Password

A four- to eight-digit number that is entered using the dialpad. A password is 
to open mailboxes or perform configuration tasks.

Path

A Path is the course an incoming call takes to or through one or more menus
CCR Tree to reach a desired destination.

Path number

An identification number assigned to a Path on each CCR Tree. The number
represents the sequence of digits that callers enter to route themselves along
Path.

Personal Mailboxes

Personal Mailboxes (appear on the telephone display as Subscriber when 
programming)

• are assigned to users by the System Administrator

• include both User Mailboxes and Guest Mailboxes

• are maintained by the mailbox owner

• can be listed in the Company Directory under the mailbox owner’s name

• are protected by a password that can be changed by the mailbox owner, o
to 0000 by the System Administrator

Primary Greeting

The main greeting played in a Personal Mailbox to callers who want to leave 
message.

Programmable memory buttons

Buttons on the Enterprise Edge one line and two line display telephones that
store feature codes and numbers.

Registering Mailboxes

Registering a mailbox adds a mailbox number to the Enterprise Edge Voice 
Messaging system using the Configuration feature code.

Reports

The Reports used to view Enterprise Edge Voice Messaging programming, th
amount of available message storage time, and CCR programming and 
administration.
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Resetting passwords

A System Administrator task that changes a mailbox password from its curre
setting back to the Enterprise Edge Voice Messaging default setting of 0000.

Resetting Enterprise Edge Voice Messaging

Returning Enterprise Edge Voice Messaging to its default settings.

Special Mailboxes

The two mailboxes used by the System Administrator and designated Operato
two Special Mailboxes are System Administrator and General Delivery.

Sub-menu

A sub-menu is any menu presented to the caller after the Home Menu. Sub-m
can lead to other sub-menus. Nine sub-menus can be added to a CCR Tree.

Subscriber

When creating new mailboxes, the choices are Subscriber (a Guest or User 
mailbox) or Information.

System Administrator

The person responsible for configuring, updating, and maintaining the Enterp
Edge Voice Messaging system.

System Administrator Mailbox

One of the two Special Mailboxes. Used by the System Administrator for sen
Broadcast Messages. This is the System Administrator’s Personal Mailbox.

Target Attendant

The Target Attendant is assigned to answer a telephone when a caller opens
mailbox to leave a message and presses ‚ to reach the Operator.

Touch Tone Phone

A push button telephone that emits DTMF tones.

Transfer 

On a CCR Tree, a Transfer prompt provides a caller with access to an extens
an external number. A Transfer prompt is assigned a one-digit number that ap
in a menu. When this number is pressed, the caller automatically transfers to 
with an individual.

User Mailboxes

User Mailboxes store messages for mailbox owners. A User Mailbox can be 
assigned to anyone in the system who has an Enterprise Edge telephone.

Voice prompts

The prerecorded voice instructions that play when callers access the Enterpr
Edge Voice Messaging features and options. Voice prompts also guide callers
the call Path of a CCR Tree.
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Directory Report 126
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Compatibility 153
E
Enabling

External Initialization 89
General Delivery Mailbox 90

Enterprise Edge ATA 2
Enterprise Edge Voice Messaging Feature 

Compatibility 151
Enterprise Edge Integrated Solution software 

configuration
tips 145

Enterprise Edge Integrated Solution software 
Feature Compatibility

Enterprise Edge ATA 2 151
Enterprise Edge Voice Messaging

Directory Number feature code 100
Enterprise Edge Integrated Solution software 

Feature compatibility 145
Glossary 157
language availability 39
line display 25
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Reports 125
set up 146
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Report 125, 128
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overview 125

Enterprise Edge Voice Messaging System 
Configuration

resetting 155
Enterprise Edge Voice Messaging System 

Configuration Report 125, 128
Erasing a CCR Path 121
Error Messages

troubleshooting 131
Expiry

password 88
Express Messaging Line

about 60
defaults 60

External Initialization 89
F
Fax answering 42
Fax On Demand

Reports 125
Feature codes

Directory Number 100
frequently used 100
Operator Status 100

Feature compatibility 145
Forwarding calls

troubleshooting 132
G
General Delivery

Mailbox 54
General Delivery Mailbox 90, 132
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Glossary 157
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assigning a CCR Tree 36
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overview 32
Primary Language 34
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Mailboxes 69
troubleshooting 132

Group List
adding a 94
delete 96
Group Message 96

preparing 93
troubleshooting 135

Group Messages 92
Group List 93

Guest
Mailbox 54

Guest Mailbox 80, 82
adding 82
Express Messaging Line 60
uses 80
using 80

Guide, organization 16
H
Hold
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Home Menu
Custom Call Routing (CCR) 107

How CCR works 103
I
Information

Mailbox 54, 83
Information Mailbox 105

adding 84
setting up 83
uses for 83

Information Message
adding 113
Custom Call Routing (CCR) 107

Information node 105
Initializing

Mailboxes 65
Intercom numbers

Enterprise Edge Voice Messaging Feature 
Compatibility 153

Interrupting a Voice Prompt 26
L
Language

changing availability 39
Language choice

Enterprise Edge Voice Messaging Feature 
Compatibility 153

Language preference
assigning 37

Leave Message
Custom Call Routing (CCR) 108

Lines 39
adding 40
configuring 39

Log prompt
troubleshooting 132
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“locked-out” 88, 134
adding 77
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Broadcast 91
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cannot be added 135
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delete 86
General Delivery 54, 90
greetings 69
Guest 54, 80
Information 54, 83
initializing 65
Message length 56
Message Waiting Notification 60
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options 85
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Special 87
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User 54
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Maximum
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Memory button

programming 100
Memory buttons 99
Menu

Custom Call Routing (CCR) 105
node 105
target 121

Menu node
adding 111
changing 120, 121

Message 70
Broadcast 91
Group 92
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mailbox 60
Messages
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Transfer 105
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Menu 120, 121
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One line display
using 25

Operating
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Operator Mailbox 91
Operator password

change 45
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Enterprise Edge 2.0 Voice Messaging Set Up and Operation Guide P0911620 Issue 02



Index  169
Outbound Transfer 56, 133
channels for outcalling 90
Outcalling Channels 90

Outcalling 90
Outcalling Channels

setting up 90
Outdial route 55, 77

mailbox 61
Overrides
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